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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.

To check for recent updates of supported system environments, go to: 

http://www.hp.com/go/TDQC_SysReq.

http://www.hp.com/go/TDQC_SysReq
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. 
As a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Welcome to This Guide

Welcome to HP Application Lifecycle Management (ALM). ALM empowers 
IT to manage the core application lifecycle, from requirements through 
deployment, granting application teams the crucial visibility and 
collaboration needed for predictable, repeatable, and adaptable delivery of 
modern applications.

How This Guide is Organized

The HP Application Lifecycle Management Installation Guide describes the 
system prerequisites and installation process for ALM Platform.

It contains the following chapters:

Chapter 1 Before You Install

Provides an overview of the product, and specifies the prerequisites for 
installing ALM Platform. In addition, it provides an installation checklist 
and other related information to help ensure that you are fully prepared 
before starting the installation process.

Chapter 2 Installing ALM Platform

Describes how to install ALM Platform.

Chapter 3 Installing Quality Center Starter Edition

Describes how to install ALM Platform for Quality Center Starter Edition.

Chapter 4 Deploying ALM Platform on WebLogic

Describes how to deploy ALM Platform on the WebLogic application server.
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Chapter 5 Deploying ALM Platform on WebSphere

Describes how to deploy ALM Platform on the WebSphere application 
server.

Chapter 6 Integrating JBoss with Apache

Describes how to configure the Apache Web server to redirect requests to 
JBoss.

Chapter 7 Getting Started 

Describes the contents of the ALM Platform program folder, how to start 
and stop ALM services, and how to log into ALM.

Chapter 8 Installing HP ALM Add-ins

Describes how to install ALM integration and synchronization solutions 
with HP and third-party tools.

Chapter 9 Verifying the IIS Configuration

Describes how to verify the Internet Information Server component settings.

Chapter 10 Customizing ALM

Describes how to customize repository and application files, and how to 
customize the names of ALM modules and menus.

Chapter 11 Changing the JBoss Heap Memory Size and Port

Describes how to change the default heap memory value and port number 
for a JBoss application server.

Chapter 12 Uninstalling ALM Platform

Describes how to uninstall ALM Platform from your server machine, and to 
uninstall the client application.

Appendix A Troubleshooting ALM Platform Installation

Troubleshooting suggestions for dealing with issues relating to the 
ALM Platform installation.
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Appendix B LW-SSO Authentication – General Reference

Information relating to Lightweight Single Sign-On (LW-SSO) 
Authentication.

Documentation Library

The Documentation Library is an online help system that describes how to 
use ALM. You can access the Documentation Library in the following ways:

➤ Click Documentation Library in the ALM Help menu to open the 
Documentation Library home page. The home page provides quick links 
to the main help topics.

➤ Click Help on this page in the ALM Help menu to open the 
Documentation Library to the topic that describes the current page.
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Documentation Library Guides

The Documentation Library consists of the following guides and references, 
available online, in PDF format, or both. PDFs can be read and printed using 
Adobe Reader, which can be downloaded from the Adobe Web site 
(http://www.adobe.com).

Application Lifecycle Management Guides

Reference Description

Using this 
Documentation 
Library 

Explains how to use the Documentation Library and how 
it is organized.

What’s New? Describes the newest features in the latest version of 
ALM. 

To access, select Help > What's New.

Product Feature 
Movies

Short movies that demonstrate the main product 
features.

To access, select Help > Product Feature Movies.

Readme Provides last-minute news and information about ALM.

Guide Description

HP ALM User Guide Explains how to use ALM to organize and execute all 
phases of the application life cycle management process. 
It describes how to specify releases, define requirements, 
plan tests, run tests, and track defects.

HP ALM 
Administrator Guide

Explains how to create and maintain projects using Site 
Administration, and how to customize projects using 
Project Customization.

HP ALM Tutorial A self-paced guide teaching you how to use ALM to 
manage the application life cycle management process.

http://www.adobe.com
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ALM Performance Center Guides

HP ALM Installation 
Guide

Describes the installation and configuration processes for 
setting up ALM Platform.

HP Business Process 
Testing User Guide

Explains how to use Business Process Testing to create 
business process tests.

Guide Description

HP ALM Performance 
Center Quick Start

A self-paced guide giving the Performance Center user a 
high level overview of creating and running performance 
tests.

HP ALM Performance 
Center Guide

Explains to the Performance Center user how to create, 
schedule, run, and monitor performance tests. Explains 
to the Performance Center administrator how to use Lab 
Management for overall lab resource management, lab 
settings management, and system configuration.

HP ALM Performance 
Center Installation 
Guide

Describes the installation processes for setting up 
Performance Center Servers, Performance Center Hosts 
and other Performance Center components.

HP ALM Performance 
Center 
Troubleshooting 
Guide

Provides information for troubleshooting problems while 
working with HP ALM Performance Center.

HP Performance 
Center of Excellence 
Best Practices

Provides best practices for successfully building and 
operating Performance Centers of Excellence.

HP Performance 
Monitoring Best 
Practices

Provides best practices for monitoring the performance 
of applications under test.

Guide Description
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ALM Best Practices

ALM API References

Guide Description

HP ALM Database 
Best Practices Guide

Provides best practices for deploying ALM on database 
servers.

HP ALM Upgrade 
Best Practices Guide

Provides methodologies for preparing and planning your 
ALM upgrade.

HP ALM Business 
Models Module Best 
Practices Guide

Provides best practices for working with the Business 
Models module.

HP ALM Entities 
Sharing Best 
Practices Guide

Provides best practices for sharing entities.

HP ALM Project 
Planning and 
Tracking Best 
Practices Guide

Provides best practices for managing and tracking 
releases.

Guide Description

HP ALM Project 
Database Reference

Provides a complete online reference for the project 
database tables and fields.

HP ALM Open Test 
Architecture API 
Reference

Provides a complete online reference for the ALM COM-
based API. You can use the ALM open test architecture to 
integrate your own configuration management, defect 
tracking, and home-grown testing tools with an ALM 
project.

HP ALM Site 
Administration API 
Reference

Provides a complete online reference for the Site 
Administration COM-based API. You can use the Site 
Administration API to enable your application to 
organize, manage, and maintain ALM users, projects, 
domains, connections, and site configuration 
parameters.
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HP ALM REST API 
Reference

Provides an online reference for the ALM REST-based API. 
You can use the REST API to access and work with ALM 
data.

HP ALM COM 
Custom Test Type 
Guide

Provides a complete online guide for creating your own 
testing tool and integrating it into the ALM 
environment.

HP ALM .NET Custom 
Test Type Developer 
Guide 

Provides a complete online guide for creating your own 
testing tool and integrating it into the ALM environment 
using a combination of DCOM and .NET classes. 

Guide Description
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Additional Online Resources

The following additional online resources are available from the ALM Help 
menu:

Part Description

Troubleshooting & 
Knowledge Base

Opens the Troubleshooting page on the HP Software 
Support Web site where you can search the Self-solve 
knowledge base. Choose Help > Troubleshooting & 
Knowledge Base. The URL for this Web site is 
http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support Opens the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You 
can also post to and search user discussion forums, 
submit support requests, download patches and updated 
documentation, and more. Choose Help > HP Software 
Support. The URL for this Web site is 
www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an 
HP Passport user and sign in. Many also require a support 
contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site Opens the HP Software Web site. This site provides you 
with the most up-to-date information on HP Software 
products. This includes new software releases, seminars 
and trade shows, customer support, and more. Choose 
Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

Add-ins Page Opens the HP Application Lifecycle Management Add-
ins Page, which offers integration and synchronization 
solutions with HP and third-party tools.

http://h20230.www2.hp.com/troubleshooting.jsp
http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/software
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1
Before You Install

This chapter provides an overview of the installation process, and specifies 
the prerequisites for installing ALM Platform.

This chapter includes:

➤ About the ALM Platform Technology on page 18

➤ The Installation Process on page 21

➤ Application Lifecycle Management Editions on page 25

➤ Installation Checklist on page 26

➤ ALM Platform Prerequisites on page 29

➤ ALM Client-Side Prerequisites on page 49

➤ Upgrading Projects and Database Schemas on page 53
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About the ALM Platform Technology

ALM Platform is an enterprise-wide application that is based on Java 2 
Enterprise Edition (J2EE) technology. J2EE technology provides a 
component-based approach to the design, development, assembly, and 
deployment of enterprise applications. Within the J2EE framework, 
ALM Platform supports clustering. A cluster is a group of application servers 
that run ALM Platform as if they were a single entity. Each application 
server in a cluster is referred to as a node or a cluster node.

Clusters provide mission-critical services to ensure maximum scalability. 
The load balancing technique within the cluster is used to distribute client 
requests across multiple application servers, making it easy to scale to an 
infinite number of users. The cluster of servers can run on Windows, Linux, 
Solaris, and HP-UX based platforms.

ALM Editions: Clustering is not supported for Quality Center Starter Edition.

Note: To install ALM Platform on cluster nodes, the ALM Platform High 
Availability option must be included in your purchase agreement. For more 
information, please contact your sales representative.
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The following diagram illustrates how ALM client requests are transmitted 
within a cluster.

➤ HP ALM Client. When users select Application Lifecycle Management or 
Site Administration on their client machine, client components are 
downloaded to their client machine. ALM uses the Component Object 
Model (COM) interface as an interprocess communicator among the 
components.

➤ Internet. Client requests are transmitted via the HTTP protocol to the 
server.

➤ Load Balancer. When working with a load balancer, client requests are 
transmitted to the load balancer and distributed according to server 
availability within the cluster.

➤ Application Server. Client requests are dispatched by servlets to the 
deployed ALM Platform application on the application server. 
ALM Platform supports JBoss, WebLogic, and WebSphere. 
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The deployed application contains Application Lifecycle Management, 
Site Administration, and associated files which are packaged into a Web 
Application Archive (WAR) file. Client requests from Application Lifecycle 
Management are dispatched to the qcbin.war file.

The Java Database Connectivity (JDBC) interface is used to communicate 
between the application server and the databases.

➤ Databases. The Application Lifecycle Management schema stores project 
information. The Site Administration schema stores domain, project, and 
user data. The schemas can reside on an Oracle or Microsoft SQL Server. 
For detailed guidelines for deploying ALM Platform on database servers, 
refer to the HP ALM Database Best Practices Guide.
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The Installation Process

Installing ALM Platform includes the following steps:
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Verify System Configurations

Note: For an up-to-date list of supported system configurations, refer to 
http://www.hp.com/go/TDQC_SysReq.

Check the following:

➤ Ensure that you have all the information for installing ALM Platform on a 
server machine. For more information, see "Installation Checklist" on 
page 26. 

➤ Ensure that you meet the prerequisites for installing ALM Platform on a 
server machine, and for running ALM on client machines. For more 
information, see "ALM Platform Prerequisites" on page 29 and "ALM 
Client-Side Prerequisites" on page 49. 

Upgrade Projects
To work with previously created projects, you must upgrade them to your 
current version of ALM Platform. For more information, see "Upgrading 
Projects and Database Schemas" on page 53.

Install ALM Platform

➤ Installing ALM Platform on your server includes the following stages:

➤ File delivery. Install ALM Platform files on the server.

➤ Server configuration. Define server configurations.

➤ You can install ALM Platform on one of the following systems: Windows, 
Solaris, Linux, or HP-UX. For more information, see Chapter 2, "Installing 
ALM Platform."

➤ For information on installing ALM Platform for ALM Starter Edition, see 
Chapter 3, "Installing Quality Center Starter Edition."

http://www.hp.com/go/TDQC_SysReq
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➤ If you are using JBoss, ALM Platform is automatically deployed on your 
application server. If you are using a WebLogic or WebSphere application 
server, you must deploy ALM Platform manually. For more information, 
see Chapter 4, "Deploying ALM Platform on WebLogic" or Chapter 5, 
"Deploying ALM Platform on WebSphere."

➤ To use ALM Platform on a JBoss application server with an Apache Web 
server, you need to configure the Apache Web server to redirect requests 
to the JBoss application server. For more information, see Chapter 6, 
"Integrating JBoss with Apache."

➤ For information on how to uninstall ALM Platform from your server 
machine, see Chapter 12, "Uninstalling ALM Platform."

Start Application Lifecycle Management
After you install ALM Platform, you launch ALM from your Web browser. 
For more information, see Chapter 7, "Getting Started."

Customize and Configure ALM
You can customize and configure ALM as follows:

➤ You can install ALM add-ins to enhance the existing functionality. For 
more information, see Chapter 8, "Installing HP ALM Add-ins".

➤ You can customize repository and application files, and the names of ALM 
modules and menus. For more information, see Chapter 10, "Customizing 
ALM".

➤ You can update the heap memory value on the JBoss application server, if 
there is a change in the number of active projects or concurrent user 
sessions in ALM Platform. You can also change the JBoss default port 
number. For more information, see Chapter 11, "Changing the JBoss Heap 
Memory Size and Port".
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➤ If you encounter a problem in the Internet Information Server (IIS) 
component after you install ALM Platform on Windows, you should 
check the IIS configuration settings. For more information, see Chapter 9, 
"Verifying the IIS Configuration".

➤ Additional suggestions for dealing with issues relating to the 
ALM Platform installation are described in Appendix A, "Troubleshooting 
ALM Platform Installation".

Install Performance Center Server and Components
To work with Performance Center, install the Performance Center server and 
components. For more information, refer to the HP ALM Performance Center 
Installation Guide.
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Application Lifecycle Management Editions

HP Application Lifecycle Management (ALM) is also available in three 
editions which provide subsets of ALM functionality — HP Quality Center 
Starter Edition, HP Quality Center Enterprise Edition, and HP ALM 
Performance Center Edition.

For detailed information about the functionality available for each edition, 
refer to the HP Application Lifecycle Management User Guide.

HP ALM Edition Description

HP ALM Complete HP ALM functionality, providing core 
functionality for managing the Application Lifecycle 
and scalable Quality Management for mature 
organizations and Centers of Excellence (CoE) 
involved with managing enterprise releases. 

HP Quality Center 
Starter Edition

For quality management teams managing small 
releases.

HP Quality Center 
Enterprise Edition

For quality management teams managing medium to 
large releases.

HP ALM Performance 
Center Edition

For managing all aspects of large-scale performance 
testing projects.
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Installation Checklist

Review and verify the following checklist before installing ALM Platform on 
your server machine. The checklist outlines the information that you must 
supply during the installation process. For more detailed information on the 
installation configurations, including permissions and privileges, see 
"ALM Platform Prerequisites" on page 29.

Check Information Required

Installation 
Machine

➤ Operating system version

➤ CPU type

➤ Free disk space

➤ Free memory

Where to get information? 

For the list of supported system environments, refer to: 
http://www.hp.com/go/TDQC_SysReq.

Setup Paths ➤ Installation path

➤ Deployment path

Notes: 

➤ You can accept the default paths offered by the Installation 
and Configuration wizards, or enter alternative paths.

➤ The installation path must not include folders with 
accented characters (for example, ä, ç, ñ).

➤ You must have full permissions on the installation and 
deployment directories. For more information, see 
"Permissions Required to Install ALM Platform" on page 31.

License Key ➤ License file

➤ Maintenance key

Where to get information? 

The license file was sent to you by email. The maintenance 
key appears on the product package.

Cluster 
Description

➤ Is clustering used? 

➤ Cluster hosts

http://www.hp.com/go/TDQC_SysReq
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Encryption 
Passphrases

➤ Confidential data storage passphrase

Note: In a cluster, use the same passphrase on all nodes.

➤ Communication security passphrase

Application 
Server

➤ Server type (JBoss, WebLogic, or WebSphere)

➤ Server version

If you use JBoss:

➤ Port number

To run JBoss as a service on Windows machines:

➤ JBoss service user name

➤ JBoss service user password

➤ JBoss service user domain

Web Server ➤ Server type (IIS or JBoss)

If you use IIS:

➤ IIS version

➤ Web site

Mail Server ➤ Server type

➤ Server host

➤ Server port

Demo Project ➤ Do you require the Web-based demo application for work 
with the HP Application Lifecycle Management Tutorial?

Database 
Server

➤ Database type

➤ Database version

➤ Database server name

➤ Database administrator user name

➤ Database administrator user password

➤ Database port

If you use Oracle:

➤ Database SID

➤ Default tablespace

➤ Temp tablespace

Check Information Required
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Site 
Administration

➤ Site Administrator user name

➤ Site Administrator password

Existing 
Quality Center 
Installation

If there is an existing Site Administration schema, provide the 
following information for the existing version: 

➤ Quality Center version

➤ Quality Center host

➤ Will the same schema be used in the new version?

➤ Database server name

➤ Database administrator user name

➤ Database administrator password

➤ Site Administration database schema name

➤ Site Administration database schema password

➤ Repository folder

➤ Site Administrator user name

➤ Site Administrator password

Repository ➤ Repository folder

Check Information Required
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ALM Platform Prerequisites

The following prerequisites must be met before you can install 
ALM Platform on your server machine.

For the ALM Platform server installation checklist, see "Installation 
Checklist" on page 26.

✔ Topics Page:

System Configurations 30

Permissions Required to Install ALM Platform 31

License File and Maintenance Key 33

Clustering Configuration 34

Security Passphrases 34

Application Server Information 35

Web Server Information 36

Mercury Tours Web Application and ALM Demo Project 37

Mail Server Information 37

Database Prerequisites for Oracle 37

Oracle RAC Support 43

Database Prerequisites for Microsoft SQL 44

Site Administration Login Credentials 48

ALM Platform Repository Path 48
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System Configurations
Verify that your server machine meets the ALM Platform system 
configurations. For the recommended and supported system configurations 
for your ALM server machine, refer to the HP Application Lifecycle 
Management 11.00 Readme.

Important: The supported environment information in the HP Application 
Lifecycle Management 11.00 Readme is accurate for the ALM 11.00 release, but 
there may be updates for ALM 11.00 patches. For the most up-to-date 
supported environments, refer to the HP Software Web site using the 
following URL: http://www.hp.com/go/TDQC_SysReq

Consider the following for implementing ALM Platform configurations:

➤ You can configure JBoss and WebLogic to work with HTTPS. For more 
information on configuring JBoss, see HP Software Self-solve knowledge 
base article KM193181 (http://h20230.www2.hp.com/selfsolve/
document/KM193181). For more information on configuring WebLogic, 
see HP Software Self-solve knowledge base article KM201153 
(http://h20230.www2.hp.com/selfsolve/document/KM201153).

After configuring work with HTTPS, you can choose to configure ALM to 
use HTTPS for the login process only by setting the 
FORCE_LOGIN_SSL_MODE site configuration parameter. For more 
information, refer to the HP Application Lifecycle Management Administrator 
Guide.

➤ In Unix systems, verify that you have a supported kernel by running 
uname -a.

➤ ALM Platform can be deployed on a VMware ESX 4.0 server. The system 
configurations of each virtual machine are the same as the ALM Platform 
server system configurations.

➤ For more information on configuring the database server, refer to the 
HP ALM Database Best Practices Guide.

http://h20230.www2.hp.com/selfsolve/document/KM193181
http://h20230.www2.hp.com/selfsolve/document/KM193181
http://h20230.www2.hp.com/selfsolve/
document/KM201153
http://www.hp.com/go/TDQC_SysReq
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Permissions Required to Install ALM Platform
Verify that you have the required permissions to install ALM Platform on a 
server machine.

If you are upgrading from a previous version of Quality Center with a 
remote repository, on the File System > Security > Property setting of the 
remote repository, add the Quality Center application server service user 
account with full network access permissions to the remote repository.

This section includes:

➤ "Installing on Windows Systems" on page 31

➤ "Installing on Unix Systems" on page 32

Installing on Windows Systems

To install ALM Platform on Windows, you must be logged on as a local or 
domain user with administrator permissions. The user name of the logged 
on user installing ALM Platform cannot include a pound sign ("#") or 
accented characters (for example, ä, ç, ñ).

Notes:

➤ If the repository is on a remote machine, or to use a Microsoft SQL server 
with Windows authentication, you must log on as a domain user and 
local administrator.

➤ Windows 2008: You must disable User Account Control (UAC) during the 
installation and configuration of ALM Platform.

You must have the following file system and registry key permissions:

➤ Full read permissions for all the files and directories under the directory in 
which ALM Platform is installed. The installation directory path is 
specified by the user during installation. By default, ALM Platform writes 
the installation files to:
C:\Program Files\HP\HP Application Lifecycle Management Platform
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➤ Full read, write, and execute permissions to the directory on which 
ALM Platform is deployed. The deployment directory is specified by the 
user during installation. By default, ALM Platform is deployed on: 

Windows 2008: C:\Users\All Users\HP\ALM

Windows 2003: C:\Documents and Settings\All Users\
Application Data\HP\ALM

➤ Full read and write permissions to the repository directory which 
contains the sa and qc directories. The repository path is specified by the 
user during installation. By default, it is located under the ALM Platform 
deployment directory. For more information on the repository, refer to 
the HP Application Lifecycle Management Administrator Guide.

➤ Full read permissions to the system root (%systemroot%) directory. The 
installer program writes the product information to the vpd.properties 
file in the system root directory. If you do not have these permissions, 
you can still install ALM Platform, but you cannot install any patches. 

➤ Full read and write permissions to the installation and configuration log 
files directory. Installation and configuration log files are written to:

Windows 2008: C:\Users\All Users\HP\ALM\log

Windows 2003: C:\Documents and Settings\All Users\
Application Data\HP\ALM\log

➤ Full read and write permissions to all the keys under 
HKEY_LOCAL_MACHINE\SOFTWARE\Mercury Interactive

Installing on Unix Systems

The following instructions describe the permissions required to install 
ALM Platform on a Unix system.

Note: The following instructions apply if you are installing as a root user. 
For instructions on how to install without root user permissions, see HP 
Software Self-solve knowledge base article KM916123 
(http://h20230.www2.hp.com/selfsolve/document/KM916123).

http://h20230.www2.hp.com/selfsolve/
document/KM916123
http://h20230.www2.hp.com/selfsolve/
document/KM916123
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You must have the following file system permissions:

➤ Full read and write permissions for all the files and directories under the 
directory on which ALM Platform is installed. The installation files are 
used for configuring the server. By default, the ALM Platform installation 
files are written to:  /opt/HP/HP_ALM_Platform.

➤ Full read and write permissions to the directory on which ALM Platform 
is deployed. The deployment directory is specified by the user during 
installation. By default, ALM Platform is deployed on: /var/opt/HP/ALM.

➤ Full read and write permissions to the repository directory which 
contains the sa and qc directories. The repository path is specified by the 
user during installation. By default, it is located under the ALM Platform 
deployment directory. For more information on the repository, refer to 
the HP Application Lifecycle Management Administrator Guide.

➤ Full read and write permissions to the installation and configuration log 
files directory. Installation and configuration log files are written to:
/var/opt/HP/ALM/log.

➤ If the file repository is located on a remote machine:

➤ On the file server machine, share the file repository directory so that 
the root user is the owner of the files.

➤ On the ALM Platform machine, or on each cluster node, create a 
mount directory that points to the file repository directory.

License File and Maintenance Key
Verify that you have the ALM Platform license file and maintenance key.

➤ You need to specify the path to the license file. The license file was sent to 
you by email and has a .license file extension by default. If you do not 
have a valid license file, you can submit a request for an ALM Platform 
license key by visiting the HP Software Support Web site 
(http://www.hp.com/go/hpsoftwaresupport) and clicking the Licenses & 
Passwords link.

➤ The maintenance key was supplied to you with the product package when 
you purchased ALM Platform. This field is not mandatory.

http://www.hp.com/go/hpsoftwaresupport
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Clustering Configuration
Check with your system administrator whether you are installing 
ALM Platform on a single node or as a cluster. For more information on 
cluster nodes, see Chapter 2, "Installing ALM Platform."

Quality Center Starter Edition: Clustering is not supported. 

If you are installing ALM Platform on cluster nodes, verify which machine 
to use as the first node to start the installation, and the number of machines 
you should use. This depends on the number of users and availability 
considerations. When installing ALM Platform on additional nodes, install 
the same version of ALM Platform on all nodes, and insert the same 
repository and database details that you used on the first node. On Unix 
systems, you must use the same path description on all nodes.

Note: To install ALM Platform on cluster nodes, the ALM Platform High 
Availability option must be included in your purchase agreement. For more 
information, contact your sales representative.

Security Passphrases
Verify that you have passphrases for confidential data and communication 
security encryption.

For secondary cluster nodes, verify that you have the confidential data 
encryption passphrase that you used to install the primary cluster.

Performance Center: You must use the same communication security 
passphrase for the ALM Platform and Performance Center server 
configurations.



Chapter 1 • Before You Install

35

Application Server Information
Verify which application server to use. You can use JBoss, WebLogic or 
WebSphere. 

Quality Center Starter Edition: You can only use a JBoss server.

If you use a JBoss application server, ALM Platform is deployed 
automatically when the installation process finishes. 

If you use a WebLogic or WebSphere application server, you must deploy 
ALM Platform manually after you install ALM Platform. For more 
information, see Chapter 4, "Deploying ALM Platform on WebLogic," or 
Chapter 5, "Deploying ALM Platform on WebSphere."

JBoss Application Server

If you use a JBoss application server, you must verify the following issues:

➤ For JBoss on Windows, verify that the user account set to run JBoss as a 
service is the same as the user account that is used to install 
ALM Platform. The user must have full administrator privileges on the 
ALM Platform machine, as described in "Permissions Required to Install 
ALM Platform" on page 31.

➤ For JBoss on Unix systems, verify that the user has full control 
permissions to run JBoss, as described in "Permissions Required to Install 
ALM Platform" on page 31.

➤ Verify that the JBoss application server heap memory size is sufficient (the 
default is up to 1024 MB). The maximum JBoss heap value cannot exceed 
your maximum memory (RAM) size. For information on changing the 
heap size after installation, see "Changing the JBoss Heap Memory Size 
and Port" on page 139.
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WebLogic/WebSphere Application Server

If you are using a WebLogic or WebSphere application server, verify the 
following issues:

➤ The user account that is used to install and run ALM Platform must have 
full permissions on the ALM Platform installation directory.

➤ If you are upgrading from a previous version of Quality Center, the user 
account that is used to install and run ALM Platform must have full 
permissions on the existing Quality Center repository directory.

Web Server Information
Verify and consider the following issues regarding the Web server:

➤ If you are using a JBoss application server, you can integrate JBoss with 
the IIS Web server or with the JBoss Web server during installation. 
Quality Center Starter Edition: You can only use a JBoss Web server.

➤ If you are using an IIS Web server on a Windows 2008 machine, you must 
make sure the following role services are installed on the server machine:

➤ ISAPI Extensions

➤ ISAPI Filters

➤ If you are using an application server other than JBoss, or JBoss with an 
Apache Web server, you must deploy the Web server after installation.

➤ If you are using an Apache Web server to integrate ALM Platform with 
JBoss, you can configure the Apache Web server to redirect requests to an 
application server. The ALM Platform installation DVD includes the 
appropriate Apache configuration files and the integration files. For 
information on how to integrate ALM Platform with Apache, see 
Chapter 6, "Integrating JBoss with Apache."
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Mercury Tours Web Application and ALM Demo Project
Verify which additional ALM Platform components you want to install:

➤ Mercury Tours. This is a sample Web-based travel reservation application 
that you must install to work with the HP Application Lifecycle Management 
Tutorial.

➤ ALM Demo Project. This helps you get started with ALM and is a 
prerequisite for working with the HP Application Lifecycle Management 
Tutorial.

After installation, in Site Administration, import the ALM_Demo.qcp 
file. For more information, refer to the HP Application Lifecycle 
Management Administrator Guide.

Mail Server Information
Verify which mail server to use. Ask your system administrator for 
assistance. If you are using an SMTP Server, check that you have the SMTP 
Server name and port. The installer checks that the specified mail server 
name and port are valid and that the mail server is running.

Database Prerequisites for Oracle
Verify that you have the following Oracle database information.

Database type and 
version

Verify that ALM Platform supports your database type and 
version. For the list of supported databases, refer to: 
http://www.hp.com/go/TDQC_SysReq.

Database server 
name

Verify the name of the database server.

Database user 
permissions

Verify that you have the database permissions required to 
install ALM Platform on the Oracle database server. For a 
list of required permissions, see "User Permissions for 
Installing ALM Platform on an Oracle Database" on 
page 39.

http://www.hp.com/go/TDQC_SysReq
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Database schema 
name and password

➤ The default Site Administration database schema name 
is qcsiteadmin_db. If you want to rename the schema, 
you can change the name in the configuration wizard. 
For more information, see step 28 on page 78.

➤ You can create your own ALM Platform user password 
for accessing the database schema.

➤ If there is an existing database schema, verify whether 
you want to:

➤ Upgrade the existing schema and switch all users to 
ALM 11.00.

➤ Create a copy of the existing schema and upgrade 
the copy. This enables you to work with ALM 11.00 
and previous versions of Quality Center 
simultaneously (recommended option).

➤ To install ALM Platform on an existing database 
schema (second node or upgrade), you must have:

➤ The existing database schema name and the 
database administrator permissions required to 
install ALM Platform on the database server.

➤ Full read/write permissions on the existing 
repository (see "Permissions Required to Install 
ALM Platform" on page 31).

➤ ALM Platform must have access to the previous Site 
Administration schema repository path.

➤ Full read/write permissions for the ALM Platform 
user to the previous Site Administration schema 
repository path.

Database tablespace 
name and size

➤ Verify the name of the database server, and check the 
connection to the database server. Ping the database 
server machine name to test DNS resolution.

➤ Verify you have the tablespace names (default and 
temporary) and the minimum tablespace sizes for 
storing the ALM Platform schema.

➤ Verify that the tablespace is not locked.
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User Permissions for Installing ALM Platform on an Oracle 
Database

To install ALM Platform on an Oracle database server, the installing database 
user must have sufficient permissions to perform certain administrative 
tasks in Oracle. These tasks include creating the ALM Platform project user 
schema, copying data between projects, and checking that there is sufficient 
storage in a specific tablespace.

If you are unable to use the Oracle system user due to security reasons, it is 
recommended that your database administrator create an ALM Platform 
database administrative user, for example qc_admin_db, with the specific 
privileges required to install ALM Platform.

Your database administrator can create an ALM Platform database 
administrative user using the example script, qc_admin_db___oracle.sql, 
which is located in the \utilities\databases\scripts directory on the 
installation DVD. This script creates the ALM Platform database 
administrative user with the recommended grants required on the database. 
Your database administrator should run the script and create this user on the 
staging database server.

This sections includes:

➤ "Database Administrative User Privileges" on page 40

➤ "Project User Schema Privileges" on page 42
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Database Administrative User Privileges

Following are the recommended privileges required by the ALM Platform 
database administrative user. Additional explanations about these privileges 
can be found in the notes at the end of the table.

Privilege Description

CREATE SESSION WITH 
ADMIN OPTION (1)

ALM Platform uses this privilege to connect to the 
database as the ALM Platform database 
administrative user.

CREATE USER Required to create a new project user schema when 
creating a new ALM project.

DROP USER When deleting an ALM project, ALM attempts to 
remove the database schema from the database 
server. If there is an insufficient privileges error, ALM 
ignores the error and requests that the user notify the 
database administrator to delete (drop) the database 
user schema.

CREATE TABLE WITH 
ADMIN OPTION (1)

Required for granting this permission to a newly 
created ALM Platform project user schema.

CREATE VIEW WITH 
ADMIN OPTION (1)

Required to create views for ALM projects.

CREATE TRIGGER WITH 
ADMIN OPTION (1)

Required to create triggers for ALM projects. ALM 
uses database triggers to collect change history for 
specific tables.

CREATE SEQUENCE WITH 
ADMIN OPTION (1)

Required to create sequences for ALM projects.

CREATE PROCEDURE 
WITH ADMIN OPTION (1)

Required to create stored packages for ALM projects. 
ALM uses packages to collect change history for 
specific tables.

CTXAPP Role WITH 
ADMIN OPTION (1)

Enables ALM to use the Oracle text searching feature. 
This role exists only if the Oracle text search 
component was installed and enabled on the 
database server.
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SELECT ON 
DBA_FREE_SPACE (2)

Required to check free space on the database server 
prior to creating a new database schema for Site 
Administration or a new project.

SELECT ON 
SYS.DBA_TABLESPACES 
(2)

Required to collect a list of tablespaces that exist on 
the database server prior to creating a new database 
schema for Site Administration or a new project.

SELECT ON 
SYS.DBA_USERS (2)

Required to verify the existence of specific database 
project users. For example, you might want to verify 
the existence of an Oracle CTXSYS user before 
creating a new ALM project.

SELECT ON 
SYS.DBA_REGISTRY (2)

Required to verify that the text search component is 
installed on the database server.

SELECT ON 
SYS.DBA_ROLES (2)

Required to verify that the text search role (CTXAPP) 
is installed on the database server.

SELECT ANY TABLE WITH 
ADMIN OPTION (1)

and

INSERT ANY TABLE

Required for various administrative operations when 
upgrading the Site Administration schema during 
installation using the copy and upgrade method, and 
for enhancing performance when copying a project 
that has the same source and target database server.

Notes:

➤ (1) An ALM Platform database administrative user must have privileges with 
Admin Option.

➤ (2) The SELECT ON SYS privileges can be given directly by the table owner, or 
through a database application role. To avoid giving these privileges each time, 
you can grant this role to the ALM Platform database administrative user. The 
recommended name for this role is QC_SELECT_ON_SYS_OBJECTS. You can 
create this role using the qc_sys_db___oracle.sql example script, which is 
located in the \utilities\databases\scripts directory on the installation DVD. 
You should run this script before you run the qc_admin_db___oracle.sql script.

Privilege Description
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Project User Schema Privileges

When creating a new project or restoring an existing project, ALM creates a 
project user schema. This user schema hosts all the tables that are used by 
the project for storing and retrieving data. Following are the required 
privileges for an ALM Platform project user schema:

Tip: The installation DVD contains an example script that describes the 
recommended permissions required for the ALM Platform database project 
user schema. This script contains information, and does not need to be run. 
It is located at \utilities\databases\scripts\qc_project_db___oracle.sql.

Project User Schema 
Privilege

Description

QUOTA UNLIMITED ON 
<default tablespace>

Required for creating database objects that are owned 
by the ALM Platform project user schema. This 
requirement allows users to create tables in the default 
tablespace. It replaces the UNLIMITED TABLESPACE 
system privilege that gave users system privileges to 
create tables in any tablespace, including the SYSTEM 
tablespace.

CREATE SESSION ALM Platform uses this privilege to connect to the 
database user schema to perform required operations, 
for example creating database objects such as tables, 
and using them to insert, retrieve, and delete data from 
them.

➤ CREATE TABLE

➤ CREATE VIEW

➤ CREATE TRIGGER

➤ CREATE SEQUENCE

➤ CREATE PROCEDURE

➤ CTXAPP Role

For a description of these privileges, see the table of 
required ALM Platform database administrative user 
privileges on page 40.
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Oracle RAC Support
Oracle RAC is a way to enhance Oracle database availability, allowing it to 
interact with more than one database instance.

ALM Platform RAC support includes:

➤ Load balancing between Oracle instances.

➤ Failover between all specified Oracle RAC nodes at initial connection.

ALM Platform RAC support does not include:

➤ TAF (Transparent Application Failover) support. A user failing to complete 
a request upon an Oracle instance crash is required to perform the activity 
again with a working Oracle instance.

To enable Oracle RAC support:

 1 Verify that a file containing information of Oracle database addresses is 
saved on your ALM Platform machine. On an Oracle client, the file is 
named tnsnames.ora. The file should contain information similar to the 
following example:

 2 Verify that you have the address of the TNS server ALM Platform should 
refer to. For example, OrgRAC.

OrgRAC =
(DESCRIPTION =

(ADDRESS_LIST=
(FAILOVER = on)
(LOAD_BALANCE = on)
(ADDRESS= (PROTOCOL = TCP)(HOST = server1)(PORT = 1521))
(ADDRESS= (PROTOCOL = TCP)(HOST = server2)(PORT = 1521))
(ADDRESS= (PROTOCOL = TCP)(HOST = server3)(PORT = 1521))

)
(CONNECT_DATA=

(SERVICE_NAME = myrac.yourcompany.com)
)

)
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Database Prerequisites for Microsoft SQL
Verify that you have the following Microsoft SQL database information.

Database type and 
version

➤ Verify that ALM Platform supports your database type 
and version. For the list of supported databases, refer 
to: http://www.hp.com/go/TDQC_SysReq.

➤ Verify the database server authentication type: 
Windows authentication or Microsoft SQL Server 
authentication. If you upgrade a project to ALM 11.00, 
you must use the same type of Microsoft SQL Server 
authentication that you used before the upgrade.

➤ For Microsoft SQL Server Windows Authentication, 
check that you can log in to the database. 

Database server 
name

Verify the name of the database server.

Database user 
permissions

Verify that you have the database permissions required to 
install ALM Platform on the Microsoft SQL database 
server (not applicable for Windows Authentication). For a 
list of required permissions, see "User Permissions for 
Installing ALM Platform on a Microsoft SQL Server" on 
page 45.

http://www.hp.com/go/TDQC_SysReq
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User Permissions for Installing ALM Platform on a Microsoft 
SQL Server

To install ALM Platform on a Microsoft SQL database server, the installing 
database user must have sufficient permissions to perform certain 
administrative tasks in SQL.

If you have the SQL sa user, you can use this user to install ALM Platform. If 
you are unable to use the SQL sa user due to security reasons, it is 
recommended that your database administrator create an ALM Platform 
database administrative user, for example td_db_admin, with the specific 
privileges required to install ALM Platform.

Database schema 
name and password

➤ The default Site Administration database schema name 
is qcsiteadmin_db. If you want to rename the schema, 
you can change the name in the configuration wizard. 
For more information, see step 28 on page 78.

➤ You can create your own ALM user password for 
accessing the database schema.

➤ If there is an existing database schema, verify whether 
you want to:

➤ Upgrade the existing schema and switch all users to 
ALM 11.00.

➤ Create a copy of the existing schema and upgrade 
the copy. This enables you to work with ALM 11.00 
and previous versions of Quality Center 
simultaneously (recommended option).

➤ To install ALM Platform on an existing database 
schema (second node or upgrade), you must have:

➤ The existing database schema name and the 
database administrator permissions required to 
install ALM Platform on the database server.

➤ Full read and write permissions on the existing 
repository (see "Permissions Required to Install 
ALM Platform" on page 31).

➤ ALM Platform must have access to the previous Site 
Administration schema repository path.

➤ Full read/write permissions for the ALM Platform 
user to the previous Site Administration schema 
repository path.
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The td_db_admin user must have the Database Creators role. You can also 
grant the td_db_admin user the Security Administrators role, which will 
allow it to create a td user with only those privileges required for running 
ALM Platform. Alternatively, you can create a td user before installing 
ALM Platform. To create a td user, follow steps 1-3 below, and type td as the 
user name. The td user should be assigned the database db_ddladmin role. It 
is important that the td user is not assigned any server role.

To create an ALM Platform database administrative user on Microsoft SQL 
Server:

 1 Open the SQL Server Management Studio.

 2 In the Object Explorer pane, under the ALM Platform database server, 
expand the Security folder.

 3 Right-click the Logins folder, and select New Login.

 4 Type td_db_admin as the user name, and select the authentication type 
(enter password if necessary).

 5 Click the Server Roles tab, and select the dbcreator option.

 6 Click OK.
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To test the ALM Platform database administrative user (SQL Server 
Authentication):

➤ To verify the select sysdatabases table permission in the master database:

➤ To verify the create database permission:

➤ To verify the drop database permission:

➤ To verify the select syslogins permission:

Note: The dbOwnerName must be set to td.

To test the ALM Platform database administrative user (Windows 
Authentication):

➤ To verify the change database context permission:

➤ To verify the create database permission:

➤ To verify the select on syslogins permission:

SELECT name FROM sysdatabases where name=<db_name>

CREATE DATABASE <dbName> -- the database name must not already exist

DROP DATABASE <database_name> -- the database name must exist

SELECT COUNT(*) FROM master..syslogins WHERE name=<dbOwnerName>

USE <dbName>

CREATE DATABASE <dbName> -- the database name must not already exist

SELECT COUNT(*) FROM master..syslogins WHERE name='<dbOwnerName>'
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➤ To verify the select on sysusers permission:

Site Administration Login Credentials
You define the site administrator name and password when you log in to 
Site Administration for the first time.

➤ For a clean installation, you can use any valid Site Administration user 
name and password.

➤ For an existing database schema, if you are using an existing Site 
Administration user, the password should be the same as the one in the 
previous version of Quality Center. In addition, the project directory 
should point to your existing domain repository.

ALM Platform Repository Path
The location of the repository directory is specified by the user during 
installation. The default location on Windows 2003 is C:\Documents and 
Settings\All Users\Application Data\HP\ALM\repository. You must have 
full control permissions on the ALM Platform repository path as described 
in "Permissions Required to Install ALM Platform" on page 31.

SELECT COUNT(*) FROM master..sysusers WHERE name='<dbOwnerName>'
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ALM Client-Side Prerequisites

The following prerequisites must be met before you can download 
HP Application Lifecycle Management to a client machine. 

System Configurations
Verify that client machines meet the ALM system configurations. For the 
supported and recommended system configurations for ALM clients, refer to 
the HP Application Lifecycle Management 11.00 Readme.

Important: The supported environment information in the HP Application 
Lifecycle Management 11.00 Readme is accurate for the ALM 11.00 release, but 
there may be updates for ALM 11.00 patches. For the most up-to-date 
supported environments, refer to the HP Software Web site using the 
following URL: http://www.hp.com/go/TDQC_SysReq

In addition, the following must be installed on client machines:

➤ Visual C++ 2005 SP1 ATL Security Update Redistributable

➤ Microsoft .NET Framework 3.5 (SP1)

✔ Topics Page:

System Configurations 49

Permissions Required to Download ALM Client 50

Internet Explorer Configuration 51

http://www.hp.com/go/TDQC_SysReq


Chapter 1 • Before You Install

50

Notes:

➤ If you are integrating ALM with other HP testing tools, you must modify 
the DCOM permissions on your client machine. For more information, 
see HP Software Self-solve knowledge base article KM187086 
(http://h20230.www2.hp.com/selfsolve/document/KM187086).

➤ You can work with the ALM client using a remote desktop.

➤ For customers using remote or mass distribution mechanisms, ALM 
client components can be deployed locally on workstations by running a 
self-extracting msi file. You build the msi file by running the HP ALM 
Client MSI Generator on the More HP Application Lifecycle Management 
Add-ins page. For more information on running add-ins, see Chapter 8, 
"Installing HP ALM Add-ins".

Permissions Required to Download ALM Client
Installing and running an ALM client does not require special permissions.

Note: Installing Site Administration requires that you have administrator 
privileges on your machine.

To enable ALM to work with HP testing tools as well as various other 
integrations and third-party tools, you must register ALM components on 
your client machine, by running the HP ALM Client Registration add-in. To 
install the add-in you must log in to the client machine with administrator 
privileges. For more information, see "Registering ALM on a Workstation" on 
page 121.

http://h20230.www2.hp.com/selfsolve/
document/KM187086
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Internet Explorer Configuration
Before you download Application Lifecycle Management on a client 
machine, you must perform the following configurations to the Internet 
Explorer browser on the client machine.

➤ Configure the Custom Level security settings. The Custom Level security 
setting should be configured for the specific zone of the ALM Platform 
server.

➤ Set Internet Explorer as the default Web browser. This ensures that 
external links to ALM entities will open in ALM.

To configure security settings on the client machine:

 1 In Internet Explorer, select Tools > Internet Options. The Internet Options 
dialog box opens.

 2 Click the Security tab. The Web content zone of the ALM Platform server 
(Internet or Local intranet) is automatically selected. Click Custom Level.

 3 In the Security Settings dialog box, configure the following settings:

Under .NET Framework-reliant components:

➤ Set Run components not signed with Authenticode to Enable.

➤ Set Run components signed with Authenticode to Enable. 

Under ActiveX controls and plug-ins:

➤ Set Run ActiveX controls and plug-ins to Enable.

➤ Set Download signed ActiveX controls to Enable or Prompt.

Note: You do not need to enable Download signed ActiveX controls if you 
install the ALM client by using the HP ALM Client MSI Generator Add-in 
on the More HP Application Lifecycle Management Add-ins page. This 
allows you to install all ALM modules on a client machine without 
downloading them through a browser. For more information on 
installing add-ins, see Chapter 8, "Installing HP ALM Add-ins".
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 4 On Windows Vista and 7:

 a Add the ALM Platform server site to the Trusted Sites security zone.

 b Disable the Protected Mode for the Trusted Sites security zone 
(Windows Vista default).

 5 Click OK.

To set Internet Explorer as the default web browser:

 1 In Internet Explorer, select Tools > Internet Options. The Internet Options 
dialog box opens.

 2 Click the Programs tab.

 3 Under Default web browser, make sure that Internet Explorer is set as the 
default browser. If not, click the Make default button.
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Upgrading Projects and Database Schemas

This section describes how to upgrade your projects and existing database 
schemas to ALM 11.00.

To upgrade from a previous Quality Center version with minimal 
interruption to your system operations, you should be familiar with the 
considerations and recommendations involved in the upgrade process. For 
information on upgrade methodology, see HP Application Lifecycle 
Management Upgrade Best Practices.

Performance Center: To work with projects created in previous 
Performance Center versions, you must upgrade your projects to align them 
with the required configurations of ALM. For details, see the HP Application 
Lifecycle Management Performance Center Installation Guide.

This section includes:

➤ Upgrading Projects from Previous Versions and Editions

➤ Upgrading Version Control

➤ Upgrading Existing Schema
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Upgrading Projects from Previous Versions and Editions
The following table describes the process required for working with a 
previously created project. For more information on upgrading projects, 
refer to the HP Application Lifecycle Management Administrator Guide.

Caution: Before upgrading a project for which a Quality Center extension is 
enabled, you must first install the updated version of the extension on 
ALM Platform 11.00. Upgrading a project before installing the updated 
extension may render the project unusable.

From version: To ALM 11.00:

Quality Center 10.00 1  Install ALM Platform 11.00. The installation process 
updates your schema.

2  Upgrade your projects using ALM Site 
Administration 11.00.

Quality Center 9.2 1  If you are working with Microsoft SQL Server 2000 
database server, you must migrate your database to 
a supported database. For more information, 
consult your database administrator.

2  Install ALM Platform 11.00. The installation process 
updates your database schema.

3  Upgrade your projects using ALM Site 
Administration 11.00. 

Quality Center 9.0 Projects must first be upgraded to Quality Center 9.2 
or Quality Center 10.00.

Quality Center 8.x, 
TestDirector 8.0, or 
TestDirector 7.6

Projects must first be upgraded to Quality Center 9.2.
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Upgrading Version Control
Upgrading Quality Center 10.00 version control enabled projects. Version 
control enabled projects from Quality Center 10.00 cannot be upgraded to 
ALM 11.00 while there are checked out entities. All entities must be checked 
in in Quality Center 10.00.

Upgrading from legacy version control projects. To work with projects from 
Quality Center 9.0 or Quality Center 9.2 that use version control, you must 
first upgrade to Quality Center 10.00, migrate legacy version control data, 
and then upgrade to ALM 11.00. For information on migrating legacy 
version control data to Quality Center 10.00, see HP Software Self-solve 
knowledge base article KM632120 
(http://h20230.www2.hp.com/selfsolve/document/KM632120).

Quality Center Starter 
Edition 11.00

1  If you are upgrading to HP ALM Quality Center 
Enterprise Edition or HP ALM, migrate your 
Microsoft SQL Server 2005 Express database to a 
supported database. For more information, consult 
your database administrator.

2  Install HP ALM Quality Center Enterprise Edition or 
HP ALM on a supported operating system. When 
upgrading an existing Site Administration database 
schema, you must use the migrated database name.

3  You do not need to upgrade your projects.

Quality Center 
Enterprise Edition 11.00

If you are upgrading to HP ALM, you do not need to 
upgrade your projects.

From version: To ALM 11.00:

http://h20230.www2.hp.com/selfsolve/
document/KM632120
http://h20230.www2.hp.com/selfsolve/
document/KM632120
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Upgrading Existing Schema
If you are upgrading to ALM 11.00 from a previous Quality Center version, 
during the installation process, you must provide the name of the existing 
database schema, and choose one of the following schema upgrade options:

➤ Upgrade existing schema. Uses the existing Site Administration database 
schema. Choose this option if you want to upgrade the existing schema 
and switch all users to ALM 11.00. If you choose this option, you cannot 
work with projects or users created in previous versions of Quality Center 
until you upgrade them to ALM 11.00.

➤ Upgrade a copy of the existing schema. Creates a copy of the existing Site 
Administration database schema, and upgrades the copy. This is the 
recommended option as it enables you to work in ALM 11.00 with new 
and upgraded projects, and to continue to work in your previous version 
of Quality Center with projects that have not been upgraded. This allows 
you to upgrade your existing projects incrementally. For further notes and 
guidelines on upgrading a copy of the existing schema, see "Guidelines 
for Upgrading a Copy of the Existing Schema" on page 57.

Note: The new database schema is created in the same tablespace as the 
existing Site Administration database.

For more information on using an existing database schema, see "Database 
Prerequisites for Oracle" on page 37, or "Database Prerequisites for Microsoft 
SQL" on page 44.
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Guidelines for Upgrading a Copy of the Existing Schema

If a Site Administration database schema exists on your database server 
machine and you choose to upgrade a copy of the existing schema, consider 
the following guidelines:

ALM users After you install ALM Platform 11.00, if you add or delete 
users, or update user details in your previous version of 
Quality Center, you must make the same changes in 
ALM 11.00.

ALM 
configuration 
parameters

After you install ALM Platform 11.00, if you modify 
configuration parameters in your previous version of 
Quality Center, you must make the same changes in 
ALM 11.00.

Server node 
configuration

If you are working with server nodes, in the Servers tab in 
Site Administration for ALM 11.00, you must reconfigure the 
settings for the ALM Platform log file and the maximum 
number of database connections.

ALM Platform 
repository path

The repository path in your previous version must be defined 
as a network path, so that it can be accessed by both the 
previous Quality Center server and by ALM Platform 11.00.

Make sure that different repository paths are defined for both 
versions.

DATACONST 
table

The following constants must be set as network paths in the 
DATACONST table: db_directory, tests_directory, 
unix_db_directory, and unix_tests_directory. This enables them 
to be accessed by both the previous Quality Center server and 
by ALM Platform 11.00.
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2
Installing ALM Platform 

This chapter describes how to install ALM Platform. It also describes how to 
install ALM Platform silently.

Note: For information on installing ALM Platform for Quality Center Starter 
Edition, see Chapter 3, "Installing Quality Center Starter Edition".

This chapter includes:

➤ About Installing ALM Platform on page 59

➤ Mounting the File System Repository in a Clustered Environment 
on page 60

➤ Installing ALM Platform on page 62

➤ Installing ALM Platform in Silent Mode on page 85

➤ Configuring the IIS Mail Service on page 86

About Installing ALM Platform

You can install ALM Platform on a single node or as a cluster. When you 
install ALM Platform on cluster nodes, all nodes must be identical. For 
example, all nodes must use the same application server, operating system, 
ALM Platform directory location, and Site Administration database. In 
addition, you must install the same version of ALM Platform on all nodes.
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If you are working in a clustered environment on a Unix system, you must 
mount the file system repository before you start the ALM Platform 
installation process. For more information, see "Mounting the File System 
Repository in a Clustered Environment" on page 60.

Note: When you are installing ALM Platform on a secondary node of a 
cluster, you are not required to set up the database, because it was set up 
when you installed the primary node. Some of the dialog boxes described in 
this installation procedure are needed only for the primary node and are not 
displayed if you are installing a secondary node.

Mounting the File System Repository in a Clustered 
Environment 

When working in a clustered environment on a Unix system, you must 
mount the file system repository before you start the ALM Platform 
installation process. The mount to the file system repository should not use 
any cache mechanisms. 

To mount a file system repository in Linux:

➤ NFS mounts: When using NFS mounts, modify the /etc/fstab file as 
follows:

➤ SMBFS mounts: When using SMBFS (mounted from a Windows 
machine), modify the /etc/fstab file as follows:

<source> <target> nfs sync,noac 0 0

<source> <target> smbfs
credentials=/root/.smbpasswd,rw,gid=<GID>,uid=<UID>,
fmask=0777,dmask=0777 0 0
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For example:

Where:

➤ //ALMPlatform/QCrepository is the UNC of the source path.

➤ uid=almadmin is a domain user. Note that qcadmin must be a user on 
the Windows server, and must belong to the Administrators group.

➤ /mnt/ALMrepository is the local folder.

The almadmin in this example must be defined in the credential file 
(/root/.smbpasswd) as follows:

Edit the /etc/samba/smb.conf file and change the workgroup value to a 
domain name (for example: HPALM).

To mount a file system repository in Solaris:

NFS mounts: When using NFS mounts, modify the /etc/vfstab file as 
follows:

//ALMPlatform/QCrepository /mnt/ALMrepository smbfs
credentials=/root/.smbpasswd,rw,gid=10,uid=almadmin, 
fmask=0777,dmask=0777 0 0

username = almadmin
password = <almadmin-password>

<source> - <target> nfs - yes sync,noac
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Installing ALM Platform

This section describes how to install ALM Platform 11.00.

Before installing ALM Platform, consider the following:

➤ Verify that you meet the installation specifications in the "ALM Platform 
Prerequisites" on page 29.

➤ If you are upgrading your projects and existing database schemas to 
ALM Platform 11.00, see "Upgrading Projects and Database Schemas" on 
page 53.

➤ If you encounter problems during the ALM Platform installation process, 
see Appendix A, "Troubleshooting ALM Platform Installation," for 
troubleshooting suggestions.

To install ALM Platform:

 1 If you have been working with a previous version of Quality Center, back 
up your existing projects before installing the new version. For more 
information, refer to the HP Application Lifecycle Management Administrator 
Guide.

 2 Log in to the ALM Platform host machine with the appropriate 
permissions. For a list of required permissions, see "Permissions Required 
to Install ALM Platform" on page 31.

 3 If Quality Center or ALM Platform is installed on the machine, uninstall 
it. For more information, see Chapter 12, "Uninstalling ALM Platform."

 4 If you are installing ALM Platform on a Windows system, make sure the 
following services are started on the machine:

➤ Secondary Logon

➤ Windows Management Instrumentation
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 5 Insert the HP ALM Platform 11.00 Software installation DVD into the 
DVD drive and run the appropriate setup file for your platform.

If you are installing on a Unix system, make sure that the DISPLAY 
environment variable is properly configured on the ALM Platform host 
machine, and that the machine from which you are installing is running 
an X-server (for example, Exceed). If the variable is not configured, the 
installation is run in console mode.

 6 The HP ALM Platform Installation wizard launches on the Welcome page. 
Click Next.

 7 The License Agreement page opens.

Read the license agreement. To accept the terms of the license agreement, 
select I Agree. 

Click Next.

 8 The Customer Information page opens. Type your Name and 
Organization. Click Next.

 9 The Select Installation Folder page opens. Specify the location to which 
you want to deliver ALM Platform installation files. To browse possible 
locations, click the Browse button, select a location, and click OK.

Make sure to enter a unique name for the installation folder. The same 
name of an existing folder in a different lettercase is not considered 
unique.

For more information on the required installation directory permissions, 
see "Permissions Required to Install ALM Platform" on page 31.

Click Next.

 10 The Confirm Installation page opens.

To review or change any settings, click Back.

To accept the settings and start the installation process, click Next. The 
ALM Platform files are installed on the server machine.

When the installation process completes, the Installation Complete page 
opens. Click Finish.

 11 The ALM Platform Configuration Wizard launches on the Welcome page. 
Click Next.
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 12 If the Configuration wizard detects settings from a previous ALM Platform 
installation, the Current Settings page opens.

➤ Select Yes to use the current settings as default settings for the current 
installation. You can make changes to any of the default settings 
during the wizard.

➤ Select No to clear all settings in the Configuration wizard.

Click Next.
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 13 The License Key page opens.

License key file. Select one of the following options:

➤ Select the ALM Platform license file path.

➤ If you do not have a license file, select Use Evaluation Key for a 30-day 
trial version of ALM Platform, and select an ALM edition. For more 
information on ALM editions, see "Application Lifecycle Management 
Editions" on page 25.

Maintenance key. Type the maintenance number supplied to you when 
you purchased ALM Platform.

For more information on the license file and maintenance key, see 
"License File and Maintenance Key" on page 33.

Click Next.
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 14 The Cluster Configuration page opens.

Select a node configuration option:

➤ First node/Standalone. Installs ALM Platform on the first node of a 
cluster or as a standalone application.

➤ Secondary node. If you have an existing node, installs ALM Platform 
on another node to create a cluster.

For more information on cluster configuration, see "Clustering 
Configuration" on page 34.

Click Next.
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 15 The Security page opens.

Passwords for accessing external systems (databases and LDAP) are stored 
by ALM Platform after encryption. Enter a Confidential data passphrase 
that ALM Platform uses to encrypt the information.

Make a note of the passphrase for future support calls.

Notes:

➤ If you are installing ALM Platform on a cluster, you must use the same 
passphrase for all nodes.

➤ After completing the server configuration wizard, you cannot change 
the confidential data encryption passphrase.
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Select Use default value to use the ALM Platform default confidential data 
encryption passphrase.

Caution: By selecting this option, the encrypted information is more 
vulnerable to unauthorized access.

 16 Communication between ALM Platform and other HP BTO applications is 
enabled after authentication by a Single Sign-On (SSO) token. Enter a 
Communication security passphrase that ALM Platform uses to encrypt 
the SSO token. For more information on the SSO token, see Appendix B, 
"LW-SSO Authentication – General Reference."

Notes:

➤ The communication security passphrase is stored as the value of the 
COMMUNICATION_SECURITY_PASSPHRASE site configuration parameter. 
For more information, refer to the HP Application Lifecycle Management 
Administrator Guide.

➤ Performance Center: You must use the same communication security 
passphrase for the Performance Center server configuration.

Click Next.
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 17 The Application Server page opens.

Select one of the following application server configuration options:

➤ JBoss Application Server. Select this option to work with JBoss.

➤ In the JBoss Server HTTP Port box, you can change the JBoss server 
HTTP port number. The default port is 8080.

Note: You can update the heap memory value and port number on the 
JBoss application server after you have installed ALM Platform. For 
details, see Chapter 11, "Changing the JBoss Heap Memory Size and 
Port."

➤ Other Application Server. Select this option to work with WebLogic or 
WebSphere. 
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 18 In the Deployment path box, specify the location in which you want to 
deploy ALM Platform application files. To browse possible locations, click 
the Browse button, select a location, and click OK.

Click Next.

 19 If you selected JBoss Application Server, the HP ALM Platform service 
page opens.

Type the User name, Password, and Domain to be used to run JBoss as a 
service. This enables the JBoss service to access your local network.
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Notes:

➤ To use a Microsoft SQL server with Windows authentication, the JBoss 
user must be the same as the logged on user, and must be a domain 
user and local administrator.

➤ If the repository is on a remote machine, the JBoss user must be a 
domain user and local administrator.

If you leave these fields blank, the local system account is used to run the 
JBoss service, and the JBoss service does not have access to your local 
network. This means that the repository and the database must be on the 
local machine.

For more information about user permissions, see “JBoss on Windows” on 
page 35.

Click Next.
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 20 If the IIS Web server is installed on your machine, proceed to step 21 on 
page 73.

If the IIS Web server is not installed on your machine, the Web Server 
page opens.

The ALM Platform installation can integrate JBoss with the IIS Web server 
or with the JBoss Web server. Alternatively, you can manually integrate 
JBoss with the Apache Web server. For more information, see Chapter 6, 
"Integrating JBoss with Apache." By default, ALM Platform integrates 
JBoss with the IIS Web server.

Choose one of the following options:

➤ To use JBoss as the Web server, click Next to continue the installation. 
Proceed to step 22 on page 74.

➤ To use IIS as the Web server, click Cancel to end the installation. Check 
that IIS is installed and running, then rerun the ALM Platform Server 
Configuration Wizard.
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 21 If the IIS Web server is installed on your machine, the Web Server 
Configuration page opens.

Select the Web server that you want to integrate with JBoss. For more 
information on the Web server options, see "Web Server Information" on 
page 36.

If you selected IIS, select the IIS Web site that you want ALM Platform to 
use. It is recommended that you use the Default Web Site.

Note: For information on how to redirect requests to JBoss from an IIS 
server on a remote machine, see HP Software Self-solve knowledge base 
article KM190530 (http://h20230.www2.hp.com/selfsolve/document/
KM190530).

Click Next.

http://h20230.www2.hp.com/selfsolve/
document/KM190530
http://h20230.www2.hp.com/selfsolve/
document/KM190530
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 22 The Mercury Tours page opens.

To help you get started with ALM, install the sample Web-based travel 
reservation application, Mercury Tours. This is a prerequisite for working 
with the HP Application Lifecycle Management Tutorial.

Note: It is recommended that you import the ALM Demo Project 
available with the ALM Platform 11.00 installation DVD. Importing this 
project enables you to run all lessons in the HP Application Lifecycle 
Management Tutorial. In Site Administration, import the ALM_Demo.qcp 
file. For more information, refer to the HP HP Application Lifecycle 
Management Administrator Guide.

Click Next. 
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 23 The Mail Server page opens.

To enable ALM Platform to send emails to users in an ALM project, choose 
a mail protocol. For SMTP Server, type the server name. 

If you selected Microsoft IIS SMTP Service, you must configure the 
Microsoft IIS SMTP service. For more information, see "Configuring the 
IIS Mail Service" on page 86.

Click Next.
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 24 The Database Server page opens.

Under Database Type, select the database type for the Site Administration 
database schema.

If you select a Microsoft SQL Server, choose the authentication type:

➤ Microsoft SQL Server (SQL Server Auth.). Authenticates the user to the 
database using a database user name and password.

➤ Microsoft SQL Server (Windows Auth.). Windows authentication relies 
on the user being authenticated by the operating system.

For more information on database requirements, see "Database 
Prerequisites for Oracle" on page 37, and "Database Prerequisites for 
Microsoft SQL" on page 44.

Note: When upgrading a project to ALM 11.00, you must use the same 
type of SQL authentication that you used before the upgrade.
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 25 Under Database Connection, specify database connection information.

To use an Oracle RAC database, proceed to step 26.

Select one of the following options:

➤ Database Parameters. Select this option to enter database server 
information using the following fields:

➤ DB host name. Type the database server name. For example, 
dbsrv01.

➤ DB port number. Type the database server port number, or accept 
the default port number.

➤ Oracle SID. Type the Oracle system identifier. This is an Oracle 
parameter that identifies the specific Oracle instance on the host 
machine on which the Oracle server is installed.

➤ Connection String. Select this option to type a formulated database 
server connection string.

 26 To use an Oracle RAC database, select Connection String, and enter a 
connection string, specifying the location of the tnsnames.ora file, and 
the TNS server that ALM Platform should refer to. Use the following 
example:

For more information on prerequisites for Oracle RAC support, see 
"Oracle RAC Support" on page 43.

Note: Verify that the ORACLE_RAC_SUPPORT site configuration 
parameter is set to "Y". For more information, refer to the HP Application 
Lifecycle Management Administrator Guide.

jdbc:HP:oracle:TNSNamesFile=<ALM Platform server>\tnsnames.ora;
TNSServerName=OrgRAC
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 27 Under Database Administrator Login, specify the following database 
connection information (Not applicable for Microsoft SQL Server 
Windows Authentication):

➤ DB admin user name. Type the name of the user with the 
administrative permissions required to install ALM Platform on the 
database server. 

➤ DB admin password. Type the database administrator password.

Click Next.

 28 The Site Administration Database Schema page opens. 

Under Selected Action, choose whether to create a new database schema, 
or to upgrade an existing database schema from a previous version of 
Quality Center.
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If you chose to upgrade an existing database schema, select one of the 
following schema upgrade options:

➤ Upgrade existing schema. Uses the existing Site Administration 
database schema. Choose this option if you want to upgrade the 
existing schema and switch all users to ALM 11.00.

➤ Upgrade a copy of the existing schema. Creates a copy of the existing 
Site Administration database schema, and upgrades the copy. Choose 
this option to work in ALM 11.00 and previous versions of 
Quality Center simultaneously.

Caution: Consider carefully before deciding which schema upgrade 
option to use. For more details on the schema upgrade options, and 
additional notes and guidelines, see "Upgrading Existing Schema" on 
page 56.

 29 For ALM Platform on an Oracle database:

If you are installing ALM Platform on a secondary node, or if the Site 
Administration database already exists, the new database schema is 
created in the same tablespace as the existing schema. Proceed to step 31.

Type the following information:

➤ Default Tablespace. Select a default storage location from the list.

➤ Temporary Tablespace. Select a temporary storage location from the 
list.
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 30 Under SA Schema Details, type the following information:

➤ Schema name. Type a Site Administration database schema name, or 
accept the default schema name.

Note: When upgrading an existing Site Administration database 
schema to work in ALM 11.00, you must use the same name that you 
used before the upgrade.

➤ Schema password. For Microsoft SQL Server (SQL Auth.): 
ALM Platform uses the td user to create the Site Administration 
database schema. For more details on the td user, see "User Permissions 
for Installing ALM Platform on a Microsoft SQL Server" on page 45.

Type a password for the td user that complies with your organization’s 
password policy, or keep the default tdtdtd password.

➤ New Schema name. If you selected Upgrade a copy of the existing 
schema, type a name under which the upgraded copy of the database 
schema is created.

Click Next.
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 31 The Site Administrator User page opens.

You use the site administrator name and password that you define in this 
dialog box to log in to Site Administration for the first time. After 
installation, you can change the site administrator or add other site 
administrators. Type a site administrator User name (maximum length 60 
characters) and Password, and retype the password to confirm.

Notes: 

➤ It is important that you remember the site administrator user name 
and password as otherwise you cannot log in to Site Administration.

➤ For an existing database schema, if you are using an existing user, the 
password should be the same as the one in the previous version of 
Quality Center. For more information, see "Site Administration Login 
Credentials" on page 48.

Click Next.
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 32 The File Repository Path page opens.

In the File repository path box, click the browse button to choose a 
repository path, or accept the default path.

Make sure to enter a unique name for the repository folder. The same 
name of an existing folder in a different lettercase is not considered 
unique.

For more information on the Repository path, see "ALM Platform 
Repository Path" on page 48.

Note: To work with cluster nodes, make sure that all nodes have access to 
the file repository path.

Click Next.
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 33 The Installation Summary page opens. To change any settings, click Back.

To accept the settings and start the configuration process, click Next.

 34 The Finish page opens.

If your application server is other than JBoss, proceed to step 35.

If your application server is JBoss, choose one of the following options:

➤ Select the Start JBoss checkbox to start the JBoss server now.

➤ Clear the Start JBoss checkbox to manually start the JBoss server later.

Click Finish.

 35 If you are prompted to restart your computer, you can choose to restart 
your computer at a later time, but you must restart your computer before 
you use ALM. You must also restart your computer before you install any 
ALM related files, such as integration add-ins.
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Note: To work with ALM Platform, you may need to disable conflicting 
applications that are running on the ALM Platform machine. For a list of 
these applications, see HP Software Self-solve knowledge base article 
KM176429 (http://h20230.www2.hp.com/selfsolve/document/KM176429).

 36 If you selected to use the JBoss application server, ALM Platform and 
Mercury Tours are automatically deployed on your application server. If 
you use a WebLogic or WebSphere application server, you must deploy 
ALM Platform and Mercury Tours manually.

The war files are located in the deployment folder of the ALM Platform 
deployment directory.

For more information on deploying ALM Platform, see Chapter 4, 
"Deploying ALM Platform on WebLogic," or Chapter 5, "Deploying 
ALM Platform on WebSphere."

 37 If you selected the IIS Web server, from the Windows Start menu, select 
Run, and type the IISReset command.

Caution: The Configuration Wizard creates the qcConfigFile.properties file 
that contains ALM Platform configuration data. This file must not be 
removed from the <Common AppData directory>\HP\ALM\conf folder.

http://h20230.www2.hp.com/selfsolve/
document/KM176429
http://h20230.www2.hp.com/selfsolve/
document/KM176429
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Installing ALM Platform in Silent Mode

You can install ALM Platform using a silent installation. A silent installation 
runs the entire setup process in the background without requiring you to 
navigate through the setup screens and input your selections. Instead, all 
configuration parameters are assigned values that you define in a 
configuration file. To run silent installations for different configurations, 
you can create multiple configuration files.

Note: When running an installation in silent mode, no messages are 
displayed. Instead, you can view installation information in the log file, 
including information on whether the installation was successful. The 
installation log file can be found under the %tmp% directory for Windows 
platforms. The log file can also be found under the home directory (~) of the 
user installing ALM Platform for Unix platforms.

To run a silent installation:

 1 Uninstall any previous installations of Quality Center from the server 
machine.

 2 Create a configuration file. 

You can create a configuration file by recording installation values during 
an installation. After installing ALM Platform, the qcConfigFile.properties 
configuration file is saved in the following path:
<ALM Platform deployment path>/HP/ALM/conf

 3 From the command line, run the appropriate silent setup file for your 
platform on the installation DVD:

➤ Windows systems: run_silent.bat

➤ Unix systems: silent.sh

In the command line, add the -c <configuration file> parameter to specify 
the path of the configuration file.

Optionally, add the -i parameter to specify an alternative installation 
path.
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Configuring the IIS Mail Service

If you selected Microsoft IIS SMTP Service in the Mail Server Properties 
dialog box, you must configure the Microsoft IIS SMTP service.

To configure the IIS mail service:

 1 Open the Internet Information Services (IIS) Manager window.

 2 In the Tree pane, right-click Default SMTP Virtual Server and choose 
Properties. The Default SMTP Virtual Server Properties dialog box opens.

 3 In the Access tab, click the Connection button. The Connection dialog 
box opens. Choose All except the list below and click OK.

 4 Click the Relay button. The Relay Restrictions dialog box opens. Choose 
All except the list below and click OK.

 5 Click OK to close the Default SMTP Virtual Server Properties dialog box.
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3
Installing Quality Center Starter Edition

This chapter describes how to install ALM Platform for Quality Center 
Starter Edition.

Note: During the installation process, the following components are 
installed: JBoss application server, JBoss web server, and Microsoft SQL 2005 
Express. If Microsoft SQL Server 2005 or 2008 is installed on the server 
machine, you can use the existing installation, by providing the database 
administrator name and password.

Before installing ALM Platform, consider the following:

➤ Verify that you meet the installation specifications in the "ALM Platform 
Prerequisites" on page 29.

➤ If you encounter problems during the ALM Platform installation process, 
see Appendix A, "Troubleshooting ALM Platform Installation," for 
troubleshooting suggestions.

To install Quality Center Starter Edition:

 1 Log in to the ALM Platform server machine with the appropriate 
permissions. For a list of required permissions, see "Permissions Required 
to Install ALM Platform" on page 31.

 2 If Quality Center or ALM Platform is installed on the machine, uninstall 
it. For more information, see Chapter 12, "Uninstalling ALM Platform."
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 3 Make sure the following services are started on the machine:

➤ Secondary Logon

➤ Windows Management Instrumentation

 4 Insert the HP ALM Platform 11.00 Software installation DVD into the 
DVD drive and run the setup.exe file for Windows 32-bit.

 5 The HP ALM Platform Installation wizard launches on the Welcome page. 
Click Next.

 6 The License Agreement page opens.

Read the license agreement. To accept the terms of the license agreement, 
select I Agree. 

Click Next.

 7 The Customer Information page opens. Type your Name and 
Organization. Click Next.

 8 The Select Installation Folder page opens. Specify the location to which 
you want to deliver ALM Platform installation files. To browse possible 
locations, click the Browse button, select a location, and click OK.

For more information on the required installation directory permissions, 
see "Permissions Required to Install ALM Platform" on page 31.

Click Next.

 9 The Confirm Installation page opens.

To review or change any settings, click Back.

To accept the settings and install the application files, click Next. The 
ALM Platform files are installed on the server machine.

When the installation process completes, the Installation Complete page 
opens. Click Finish.

 10 The ALM Platform Configuration Wizard launches on the Welcome page. 
Click Next.
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 11 If the Configuration wizard detects settings from a previous ALM Platform 
installation, the Current Settings page opens.

➤ Select Yes, to use the current settings as default settings for the current 
installation. You can make changes to any of the default settings 
during the wizard.

➤ Select No, to clear all settings in the Configuration wizard.

Click Next.
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 12 The License Key page opens.

License key file. Select one of the following options:

➤ Select the ALM Platform license file path.

➤ If you do not have a license file, select Use Evaluation Key for a 30-day 
trial version of ALM Platform, and select an ALM edition. For more 
information on ALM editions, see "Application Lifecycle Management 
Editions" on page 25.

Maintenance key. Type the maintenance number supplied to you when 
you purchased ALM Platform.

For more information on the license file and maintenance key, see 
"License File and Maintenance Key" on page 33.

Click Next.
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 13 The Security page opens.

Passwords for accessing external systems (databases and LDAP), are stored 
by ALM Platform after encryption. Enter a Confidential data passphrase 
that ALM Platform uses to encrypt the information.

Make a note of the passphrase for future support calls.

Notes:

➤ If you are installing ALM Platform on a cluster, you must use the same 
passphrase for all nodes.

➤ After completing the server configuration wizard, you cannot change 
the confidential data encryption passphrase.
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Select Use default value to use the ALM Platform default confidential data 
encryption passphrase.

Caution: By selecting this option, the encrypted information is more 
vulnerable to unauthorized access.

 14 Communication between ALM Platform and other HP BTO applications is 
enabled after authentication by a Single Sign-On (SSO) token. Enter a 
Communication security passphrase that ALM Platform uses to encrypt 
the SSO token. For more information on the SSO token, see Appendix B, 
"LW-SSO Authentication – General Reference."

Notes:

➤ The communication security passphrase is stored as the value of the 
COMMUNICATION_SECURITY_PASSPHRASE site configuration parameter. 
For more information, refer to the HP Application Lifecycle Management 
Administrator Guide.

➤ Performance Center: You must use the same communication security 
passphrase for the Performance Center server configuration.

Click Next.
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 15 The Application Server page opens.

Specify the location in which you want to deploy ALM Platform 
application files. To browse possible locations, click the Browse button, 
select a location, and click OK.

Click Next.
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 16 The Mail Server page opens.

To enable ALM Platform to send emails to users in an ALM project, choose 
a mail protocol. For SMTP Server, type the server name. 

If you selected Microsoft IIS SMTP Service, you must configure the 
Microsoft IIS SMTP service. For more information, see "Configuring the 
IIS Mail Service" on page 86.

Click Next.
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 17 The Database Server page opens.

If a Microsoft SQL database is not installed on the server machine, the 
Configuration Wizard installs Microsoft SQL Express. Enter and confirm a 
password for the default sa database administrator.

If a Microsoft SQL database is installed on the server machine, enter the 
database administrator name and password.

Click Next.
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 18 The Site Administrator User page opens.

You use the site administrator name and password that you define in this 
dialog box to log in to Site Administration for the first time. After 
installation, you can change the site administrator or add other site 
administrators from Site Administration.

Type a site administrator User name (maximum length 60 characters) and 
Password, and retype the password to confirm.

Note: It is important that you remember the site administrator user name 
and password as otherwise you cannot log in to Site Administration.

Click Next.

 19 The Installation Summary page opens. To change any settings, click Back.

To accept the settings and start the configuration process, click Next.
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 20 The Finish page opens.

Choose one of the following options:

➤ Select the Start JBoss checkbox to start the JBoss server now.

➤ Clear the Start JBoss checkbox to manually start the JBoss server later.

Click Finish.

 21 If Microsoft SQL Server Express is already installed on the machine, you 
are prompted to enter the administrator name and password.

 22 If you are prompted to restart your computer, you can choose to restart 
your computer at a later time, but you must restart your computer before 
you configure or use ALM Platform. You must also restart your computer 
before you install any ALM Platform related files, such as integration 
add-ins.
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Note: To work with ALM Platform, you may need to disable conflicting 
applications that are running on the ALM Platform machine. For a list of 
these applications, see HP Software Self-solve knowledge base article 
KM176429 (http://h20230.www2.hp.com/selfsolve/document/KM176429).

Caution: The Configuration Wizard creates the qcConfigFile.properties file 
that contains ALM Platform configuration data. This file must not be 
removed from the <Common AppData directory>\HP\ALM\conf folder.

http://h20230.www2.hp.com/selfsolve/
document/KM176429
http://h20230.www2.hp.com/selfsolve/
document/KM176429
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4
Deploying ALM Platform on WebLogic

To work with ALM Platform on a WebLogic application server, you must 
deploy ALM Platform after installation. You also need to undeploy and 
redeploy ALM Platform when installing patches or updating ALM Platform 
files.

Notes: 

➤ You can change the WebLogic user name without having to reinstall 
ALM Platform. For more information, see HP Software Self-solve 
knowledge base article KM195708 (http://h20230.www2.hp.com/
selfsolve/document/KM195708).

➤ When ALM Platform is deployed on a WebLogic application server, a 
ClassNotFound Java exception might occur when one of the internal Java 
classes is not found. For more information, see HP Software Self-solve 
knowledge base article KM524610 (http://h20230.www2.hp.com/
selfsolve/document/KM524610).

This chapter includes: 

➤ Deploying ALM Platform on WebLogic on page 100

➤ Undeploying ALM Platform on WebLogic on page 102

http://h20230.www2.hp.com/selfsolve/
document/KM195708
http://h20230.www2.hp.com/selfsolve/
document/KM195708
http://h20230.www2.hp.com/selfsolve/
document/KM524610
http://h20230.www2.hp.com/selfsolve/
document/KM524610
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Deploying ALM Platform on WebLogic

This section describes how to deploy ALM Platform on a WebLogic 
application server.

Note: When restarting the ALM Platform application on WebLogic, you 
must restart the WebLogic domain on which ALM Platform is deployed, 
rather than restarting the ALM Platform application in the WebLogic 
console.

To deploy ALM Platform on WebLogic:

 1 In the setDomainEnv.cmd file, update the CLASSPATH line:

➤ On Windows systems:

In the setDomainEnv file, add to the following line:

the phrase:

where <BEA> is the WebLogic directory.

➤ On Unix systems:

In the setDomainEnv file, add to the following line:

the phrase:

where <BEA> is the WebLogic directory.

set POST_CLASSPATH=%POST_CLASSPATH%;
%DATABASE_CLASSPATH%;%ARDIR%\xqrl.jar;

<BEA>\modules\com.bea.core.apache.xercesImpl_2.8.1.jar;
<BEA>\modules\com.bea.core.apache.xalan_2.7.0.jar;

POST_CLASSPATH="${POST_CLASSPATH}${CLASSPATHSEP}
${DATABASE_CLASSPATH}${CLASSPATHSEP}${ARDIR}/xqrl.jar

${CLASSPATHSEP}<BEA>/modules/com.bea.core.apache.xercesImpl_2.8.1.jar
${CLASSPATHSEP}<BEA>/modules/com.bea.core.apache.xalan_2.7.0.jar
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 2 Stop and start WebLogic.

 3 Navigate to the ALM Platform deployment directory, and open the 
\deployment folder. By default, the deployment directory is:
 C:\Documents and Settings\All Users\Application Data\HP\ALM on 
Windows, or /var/opt/HP/ALM on Unix systems.

 4 Copy the mtours.war and qcbin.war files to the <WebLogic home>/server 
or <WebLogic domain home>/servers directory.

Note: The mtours.war file is only available if you installed Mercury Tours. 

 5 Start Admin Server on the WebLogic domain.

 6 Log in to the WebLogic Server Administration Console. The default 
address is http://<WebLogic server machine name>:7001/console. 
Perform the following steps:

 a If necessary, click Lock & Edit.

 b In the left pane of the console, click the Deployments node.

 c In the right pane, click Install.

 d In the Install Application Assistant, click Current Location: <WebLogic 
machine name>.

 e Navigate to the <WebLogic home>/server or <WebLogic domain 
home>/servers directory, and select the qcbin.war file.

 f Click Next.

 g Choose Install this deployment as an application, and click Next.

 h In the Optional Settings page, make sure that the name of the 
deployment is qcbin, and click Next.

 i Click Finish.

 j Click Activate Changes.

 k Click the Deployments node.
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 l Select the qcbin Web Application, and choose Start > Servicing all 
requests.

 m Repeat to deploy mtours.war.

 7 When the deployment process completes, start ALM Platform. For more 
information, see "Starting and Stopping ALM Platform Services" on 
page 115.

Undeploying ALM Platform on WebLogic

If you install a patch or update the qcbin.war file, you need to undeploy and 
redeploy the war file for the changes to take effect in ALM Platform.

To undeploy ALM Platform on WebLogic:

 1 Log in to the WebLogic Server Administration Console. The default 
address is http://<WebLogic server machine name>:7001/console. 
Perform the following steps:

 a If necessary, click Lock & Edit.

 b In the left pane of the console, click the Deployments node.

 c Select the qcbin Web Application, and click Stop.

 d Select the qcbin Web Application, and click Delete.

 e Click Yes to confirm.

 f Click Activate Changes.

 g Repeat to undeploy mtours.war.

 2 Delete the war files from the <WebLogic home>/server or <WebLogic 
domain home>/servers directory.
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5
Deploying ALM Platform on WebSphere

To work with ALM Platform on a WebSphere application server, you must 
deploy ALM Platform after installation. You also need to undeploy and 
redeploy ALM Platform when installing patches or updating ALM Platform 
files.

This chapter includes: 

➤ Deploying ALM Platform on WebSphere on page 103

➤ Undeploying ALM Platform on WebSphere on page 105

Deploying ALM Platform on WebSphere

This section describes how to deploy ALM Platform on a WebSphere 
application server.

Note: Verify the default maximum upload file size on the WebSphere 
application server. If the qcbin.war file size is larger than the default file size, 
you must increase the default maximum upload file size accordingly.

To deploy ALM Platform on WebSphere:

 1 Start the WebSphere application server.

 2 Launch the WebSphere Administrative Console.

 3 In the left pane, select Servers > Server Types > WebSphere application 
servers.
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 4 In the Application servers table, click your Web server link. For example, 
server1.

 5 In the Configuration tab, under Server-specific Application Settings, 
make sure the Classloader policy field is set to Multiple.

 6 Perform the following steps to deploy the ALM Platform qcbin.war and 
mtours.war files: 

 a In the console navigation tree, select Applications > New application > 
New Enterprise Application.

 b Enter the full remote file system path of the qcbin.war file, that was 
created during the installation of ALM Platform. For example:

<deployment directory>\ALM\deployment\qcbin.war

 c Select Fast Path.

 d On the Context root for Web modules panel, type qcbin as the context 
root of the Web module. 

 e On the subsequent panels, choose the default options, and click Next 
until you reach the Summary panel. 

 f On the Summary panel, verify the settings, and click Finish. 

 g If the application installs successfully, a confirm message is displayed. 
Click Save.

 h If you installed Mercury Tours, repeat to deploy mtours.war.

 7 In the left pane of the console, select Applications > Application Types > 
WebSphere enterprise applications.

 8 In the Enterprise Applications table, click the qcbin.war link.

 9 Click the Class loading and update detection link.

 10 Make sure the following settings are selected:

➤ Class loader order: Classes loaded with local class loader first (parent 
last)

➤ WAR class loader policy: Single Class loader for application

 11 In the Enterprise Applications table, start the deployed qcbin application.

 12 Stop and start WebSphere.
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 13 When the deployment process completes, start ALM Platform. For more 
information, see "Starting Application Lifecycle Management" on 
page 116.

Undeploying ALM Platform on WebSphere

If you install a patch or update the qcbin.war file, you need to undeploy and 
redeploy the war file for the changes to take effect in ALM Platform. 

To undeploy ALM Platform on WebSphere:

 1 Start the WebSphere application server.

 2 Launch the WebSphere Administrative Console and perform the 
following steps to undeploy the war files: 

 a In the Administrative Console, choose Applications > Enterprise 
Application.

 b Select qcbin.war and click Stop. 

 c Select qcbin.war and click Uninstall.
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6
Integrating JBoss with Apache

To use ALM Platform with an Apache Web server, you need to configure the 
Apache Web server to redirect requests to the JBoss application server.

This chapter includes:

➤ About Integrating JBoss with Apache on page 107

➤ Integrating JBoss with Apache on Windows on page 108

➤ Integrating JBoss with Apache on Unix Platforms on page 109

➤ Apache-JBoss Integration Configuration Files on page 110

About Integrating JBoss with Apache

When you install ALM Platform, it does not automatically configure Apache 
to redirect requests to the JBoss application server. You must perform this 
configuration manually. The ALM Platform installation DVD contains all 
the required files to enable you to configure the Apache-JBoss integration on 
Windows or Unix platforms.

All requests handled by the Apache Web server are redirected to a Tomcat 
server (which is a Servlet container delivered with JBoss). The 
communication between Apache and JBoss is implemented by using the 
AJP13 protocol, using an appropriate connector (called mod_jk).
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Integrating JBoss with Apache on Windows

You must integrate JBoss on the Apache Web server for Windows.

To integrate JBoss with Apache:

 1 Install ALM Platform with JBoss as the application server and Web server.

 2 Install the Apache Web server.

 3 Navigate to the <Apache Home directory>\conf directory.

 4 Navigate to ApacheIntegration\windows, located on the ALM Platform 
DVD. The qc_integration folder is displayed.

 5 Copy the qc_integration folder and its contents to the <Apache Home 
directory>\conf directory.

 6 Under the <Apache Home directory>\conf\qc_integration directory, 
create a log folder, if it does not already exist.

 7 Download mod_jk.so module compatible with your Apache Web server's 
version from http://tomcat.apache.org/download-connectors.cgi, and copy it 
to the <Apache Home directory>\conf\qc_integration directory.

 8 Rename the mod_jk module as mod_jk.so. For example, if you 
downloaded mod_jk-1.2.27-httpd-2.2.10.so, rename it as mod_jk.so.

 9 Add the following lines to the httpd.conf file in the <Apache Home 
directory>\conf directory:

 10 Restart the Apache Web server.

You can now connect to your ALM Platform site using the following URL: 
http://<ALM Platform server name>[<:port number>]/qcbin.

For more details regarding the Apache-Jboss integration configuration 
files, see "Apache-JBoss Integration Configuration Files" below.

#ALM Platform integration:This includes points to the Jboss-Apache #configuration 
file (for ALM Platform)
#Load mod_jk module
LoadModule   jk_module conf\qc_integration\mod_jk.so
Include conf\qc_integration\mod_jk.conf

http://tomcat.apache.org/download-connectors.cgi
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Integrating JBoss with Apache on Unix Platforms

You must integrate JBoss on the Apache Web server for Unix platforms.

To integrate JBoss with Apache on Unix platforms:

 1 Install ALM Platform with JBoss as the application server and Web server.

 2 Install the Apache Web server.

 3 Navigate to the <Apache Home directory>/conf directory.

 4 Navigate to ApacheIntegration/UnixLike, located on the ALM Platform 
DVD. The qc_integration folder is displayed.

 5 Copy the qc_integration folder and its contents to the <Apache Home 
directory>/conf directory.

 6 Under the <Apache Home directory>\conf\qc_integration directory, 
create a log folder, if it does not already exist.

 7 Download mod_jk.so module compatible with your Apache Web server's 
version from http://tomcat.apache.org/download-connectors.cgi, and copy it 
to the <Apache Home directory>/conf/qc_integration directory.

 8 Rename the mod_jk module as mod_jk.so. For example, if you 
downloaded mod_jk-1.2.27-httpd-2.2.10.so, rename it as mod_jk.so.

 9 Add the following lines to the httpd.conf file in the <Apache Home 
directory>/conf directory:

 10 Restart the Apache Web server.

You can now connect to your ALM Platform site using the following URL: 
http://<ALM Platform server name>[<:port number>]/qcbin.

For more details regarding the Apache-Jboss integration configuration 
files, see "Apache-JBoss Integration Configuration Files" below.

#Quality Center integration:This includes points to the Jboss-Apache
#configuration file (for Quality Center)
#Load mod_jk module
LoadModule jk_module conf/qc_integration/mod_jk.so
Include conf/qc_integration/mod_jk.conf

http://tomcat.apache.org/download-connectors.cgi
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Apache-JBoss Integration Configuration Files

The following files are related to the Apache-JBoss integration:

➤ mod_jk.so. This file is the connector between the Apache Web server and 
the Tomcat component delivered with JBoss.

➤ httpd.conf. This is the configuration file for the Apache Web server. 

After integrating JBoss with Apache, the following lines can be found in 
the file:

On Windows systems:

On Unix systems:

➤ workers.properties. This file defines a Tomcat instance that waits to 
execute requests on behalf of a Web server (in this case Apache).

The content of the file defines a worker (an instance of Tomcat) that 
handles ALM Platform requests (in this case the worker name is 
jboss0_ajp13_qc.)

LoadModule  jk_module conf\qc_integration\mod_jk.so
Include conf\qc_integration\mod_jk.conf

LoadModule  jk_module conf/qc_integration/mod_jk.so
Include conf/qc_integration/mod_jk.conf

# Defining a worker named jboss0_ajp13_qc and of type ajp13
# Note that the name and the type do not have to match.
worker.list=jboss0_ajp13_qc
worker.jboss0_ajp13_qc.port=8009
worker.jboss0_ajp13_qc.type=ajp13
worker.jboss0_ajp13_qc.host=localhost
worker.jboss0_ajp13_qc.lbfactor=50 
worker.jboss0_ajp13_qc.cachesize=10 
worker.jboss0_ajp13_qc.cache_timeout=600 
worker.jboss0_ajp13_qc.socket_keepalive=1 
worker.jboss0_ajp13_qc.socket_timeout=300
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➤ mod_jk.conf. This is a configuration file containing information 
describing which requests are redirected from Apache to the Tomcat 
instance. It also contains the path to the workers.properties file and 
general configuration issues.

On Windows systems:

# Where to find workers.properties
# Update this path to match your conf directory location (put workers.properties next 
to httpd.conf)
JkWorkersFile conf\qc_integration\workers.properties
# Where to put jk logs
# Update this path to match your logs directory location (put mod_jk.log next to 
access_log)
JkLogFile     conf\qc_integration\log\mod_jk.log
# Set the jk log level [debug/error/info]
JkLogLevel  info
# Select the log format
JkLogStampFormat "[%a %b %d %H:%M:%S %Y] "
# JkOptions indicate to send SSL KEY SIZE, 
JkOptions     +ForwardKeySize +ForwardURICompat -ForwardDirectories
#Order to flush response output stream whenever flushed in tomcat
JkOptions     +FlushPackets
# JkRequestLogFormat set the request format 
# JkRequestLogFormat     "%w %V %T"
# Send everything for context /examples to worker named worker1 (ajp13)
JkMount /memory jboss0_ajp13_qc
JkMount /memory/* jboss0_ajp13_qc
JkMount /jk jboss0_ajp13_qc
JkMount /jk/* jboss0_ajp13_qc
JkMount /qcbin jboss0_ajp13_qc
JkMount /qcbin/* jboss0_ajp13_qc
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On Unix systems:

# Where to find workers.properties
# Update this path to match your conf directory location (put workers.properties next 
to httpd.conf)
JkWorkersFile conf/qc_integration/workers.properties
# Where to put jk logs
# Update this path to match your logs directory location (put mod_jk.log next to 
access_log)
JkLogFile     conf/qc_integration/log/mod_jk.log
# Set the jk log level [debug/error/info]
JkLogLevel info 
# Select the log format
JkLogStampFormat "[%a %b %d %H:%M:%S %Y] "
# JkOptions indicate to send SSL KEY SIZE, 
JkOptions     +ForwardKeySize +ForwardURICompat -ForwardDirectories
#Order to flush response output stream whenever flushed in tomcat
JkOptions     +FlushPackets
# JkRequestLogFormat set the request format 
# JkRequestLogFormat     "%w %V %T"
# Send everything for context /examples to worker named worker1 (ajp13)
JkMount /memory jboss0_ajp13_qc
JkMount /memory/* jboss0_ajp13_qc
JkMount /jk jboss0_ajp13_qc
JkMount /jk/* jboss0_ajp13_qc
JkMount /qcbin jboss0_ajp13_qc
JkMount /qcbin/* jboss0_ajp13_qc
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7
Getting Started

This chapter introduces ALM Platform options and resources. It also 
explains how to start Application Lifecycle Management.

This chapter includes:

➤ Browsing the ALM Platform Program Folder on page 113

➤ Starting and Stopping ALM Platform Services on page 115

➤ Starting Application Lifecycle Management on page 116

➤ Registering ALM on a Workstation on page 121

Browsing the ALM Platform Program Folder

In Windows, after the ALM Platform setup process is complete, the 
following items are added to your HP ALM Platform program folder 
(Start > Programs > HP ALM Platform):

Option (A-Z) Description

ALM Platform Opens the Application Lifecycle Management 
application. For more information, refer to the 
HP Application Lifecycle Management User Guide.

Extension Deployment 
Tool

Enables you to deploy HP ALM Platform extensions.
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Note: If you are using an application server other than JBoss, only 
ALM Platform and Mercury Tours are available in the program folder.

Mercury Tours Opens a sample flight reservation Web application. 
This Web application is used as a basis for the 
HP Application Lifecycle Management Tutorial. For 
more information, refer to the HP Application Lifecycle 
Management Tutorial.

Note: This application is only available if you selected 
it during the ALM Platform installation.

Online Documentation Opens the Documentation Library, providing access to 
ALM guides and references that are available online, in 
PDF format, or both.

Readme Opens the HP Application Lifecycle Management 
Readme, which provides the latest news and 
information about ALM.

Server Configuration 
Wizard

Runs the HP ALM Platform Configuration Wizard, 
enabling you to reconfigure ALM Platform.

Caution: Use this option only if you have not yet 
started work in ALM.

Server Deployment 
Wizard

Redeploys ALM Platform. Run after making changes to 
the Site Administration repository or application 
folders. For more information, see Chapter 10, 
"Customizing ALM."

Site Administration Opens the Site Administration application. For more 
information, refer to the HP Application Lifecycle 
Management Administrator Guide.

Option (A-Z) Description
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Starting and Stopping ALM Platform Services

This section describes how to start or stop ALM Platform services.

To start or stop ALM Platform services from Windows: 

In the system tray, right-click the ALM Platform icon and choose Start 
ALM Platform or Stop ALM Platform.

Tip: If you are working with JBoss, you can also start and stop ALM Platform 
from the HP ALM Platform service in the Services manager.

To start or stop ALM Platform services from non-Windows systems: 

➤ If you are working with JBoss, run the following commands:

➤ If you are working with WebLogic, run the following commands:

To start: <ALM deployment directory>/jboss/bin/run.sh start

To stop: Use one of the following options:

➤ <ALM deployment directory>/jboss/bin/run.sh stop 
(or Ctrl-C in console)

➤ kill <jboss process ID>

To start: <WebLogic installation directory>/user_projects/domains/
<ALM domain name>/startWeblogic.sh

To stop: Use one of the following options:

➤ <WebLogic installation directory>/user_projects/domains/
<ALM domain name>/stopWeblogic.sh

➤ kill <weblogic process ID>
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➤ If you are working with WebSphere, run the following commands:

Starting Application Lifecycle Management

You launch HP Application Lifecycle Management (ALM) on your 
workstation from your Web browser.

You can work with multiple versions of ALM side-by-side on a workstation. 
This includes multiple ALM 11.00 clients connecting to different 
ALM Platform servers, and a single Quality Center 10.00 or 9.2 client.

To start: <WebSphere installation 
directory>/WebSphere/AppServer/bin/startServer.sh 
<WebSphere server name>

To stop: <WebSphere installation 
directory>/WebSphere/AppServer/bin/stopServer.sh
<WebSphere server name>
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Notes:

➤ You can work with only one version of Site Administration on a 
workstation simultaneously. Before opening Site Administration, close 
other versions of Site Administration and Quality Center running on the 
machine.

➤ To enable you to log in to Application Lifecycle Management, you must 
first create a project in Site Administration. For more information, refer 
to the HP Application Lifecycle Management Administrator Guide.

➤ To enable ALM to work with HP testing tools as well as third-party and 
custom tools, you must run the HP ALM Client Registration add-in, that 
registers ALM components on the client machine. For more information, 
see "Registering ALM on a Workstation" on page 121.

➤ If your users connect to ALM over a virtual environment, such as Citrix 
or VMware, you can deploy ALM components on a shared location that 
all users can access. To enable a shared deployment, run the Shared 
Deployment for Virtual Environments add-in from the HP Application 
Lifecycle Management Add-ins page. For more information, see 
Chapter 8, "Installing HP ALM Add-ins."



Chapter 7 • Getting Started

118

To start Application Lifecycle Management:

 1 Open your Web browser and type your ALM Platform URL
http://<ALM Platform server name>[<:port number>]/qcbin.

The Application Lifecycle Management Options window opens.

The Application Lifecycle Management Options window contains the 
following links:

Option Description

Application Lifecycle 
Management

Opens the ALM application. For more information, 
refer to the HP Application Lifecycle Management User 
Guide.

Site Administration Opens the Site Administration application. For more 
information, refer to the HP Application Lifecycle 
Management Administrator Guide.

Add-ins Page Opens the HP Application Lifecycle Management 
Add-ins page. For more information, see "Installing 
HP ALM Add-ins" on page 125.

Readme Opens the ALM Readme, which provides the latest 
news and information about ALM.
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 2 Click the Application Lifecycle Management link. Each time ALM is run, 
it carries out a version check. If it detects a newer version, it downloads 
the necessary files to your machine.

Notes:

➤ Windows Vista and 7: If you do not have administrator privileges on 
your machine, and a Security Warning displays, click Don’t Install. You 
will be redirected to the Install screen.

➤ If you run ALM over a virtual environment, such as Citrix or VMware, 
only the system administrator can install a new version.

Follow the on-screen instructions.

Note: If files are downloaded, but the Login window does not display, you 
must install a Microsoft Hotfix on your machine. For more information, 
see HP Software Self-solve knowledge base article KM905289 
(http://h20230.www2.hp.com/selfsolve/document/KM905289).

http://h20230.www2.hp.com/selfsolve/
document/KM905289
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After the ALM version has been checked and files have been updated as 
necessary, the Application Lifecycle Management Login window opens.

 3 In the Login Name box, type your user name.

 4 In the Password box, type the password. If you cannot remember your 
password, click the Forgot Password link. For more information, refer to 
the HP Application Lifecycle Management User Guide.

 5 Select the Automatically log in to my last domain and project on this 
machine check box if you want ALM to automatically log in to the last 
project in which you were working.

 6 Click Authenticate. ALM verifies your user name and password and 
determines which domains and projects you can access. If you specified 
automatic login, ALM opens.

If authentication fails, check your user name and password are correct 
and try again.
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 7 In the Domain list, select a domain. By default, the last domain in which 
you were working is displayed.

 8 In the Project list, select a project. By default, the last project in which 
you were working is displayed.

 9 Click Login. ALM opens and displays the module in which you last 
worked during your previous session.

Registering ALM on a Workstation

To enable you to work with other HP testing tools as well as third-party and 
custom tools, ALM must be registered on the client machine.

Note: If you are running previous versions of Quality Center on your 
machine, before registering ALM, make sure that all instances of 
Quality Center and any Quality Center integration tools are closed.

For a list of the tools that require registering ALM on a machine, see "Tools 
that Require Registering ALM Client Components" on page 123.

To register ALM on a workstation:

 1 Log on to the machine as a local user or a domain user with administrator 
privileges. Ensure that you have the registry and file system permissions 
listed below.

Windows Vista and 7: Open the Web browser as administrator.

 2 Run HP ALM Client Registration from the HP Application Lifecycle 
Management Add-ins page. For more information, see Chapter 8, 
"Installing HP ALM Add-ins."

 3 Close and reopen the Web browser.
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Permissions Required to Register ALM on a Workstation
You must have full read and write permissions on the following registry 
keys:

➤ HKEY_CLASSES_ROOT

➤ HKEY_CURRENT_USER\Software

➤ HKEY_LOCAL_MACHINE\SOFTWARE

You must have the following file system permissions:

➤ Full read and write permissions on the HP\ALM-Client deployment folder. 
This is located at:

➤ Windows Vista and 7: %ALLUSERSPROFILE%

➤ Windows XP: C:\Documents and Settings\All Users\Application Data

➤ Full read and write permissions to the Temp (%TEMP% or %TMP%) 
directory. The installer program writes installation and log files to this 
directory. This is generally located at 
C:\Documents and Settings\<username>\Local Settings\Temp.
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Tools that Require Registering ALM Client Components
The following tools require that ALM client components are registered on a 
client machine.

HP ALM Add-ins ➤ QuickTest Professional Add-in

➤ Microsoft Word Add-in

➤ Microsoft Excel Add-in

➤ HP Screen Recorder Add-in

➤ Service Test Add-in

➤ HP ALM Synchronizer

➤ Defects and Requirements Exchange with HP Service 
Manager and HP ALM

HP ALM Extensions ➤ HP Business Process Testing Enterprise Extension

Note: Required only if working with QTP/STM agents 
remotely.

Other ➤ QuickTest Professional tests

Note: Required to run tests, and to submit defects from 
the Run Results Viewer.



Chapter 7 • Getting Started

124



125

8
Installing HP ALM Add-ins

HP Application Lifecycle Management offers integration and 
synchronization solutions with HP and third-party tools. To integrate ALM 
with other tools, you may need to install appropriate add-ins from the 
HP Application Lifecycle Management Add-ins page.

Note: If you are integrating ALM with another tool, you can verify that you 
are using a supported version. On the Add-ins page, click the More 
HP Application Lifecycle Management Add-ins link, and choose the 
appropriate integrations matrix.

To install an ALM add-in:

 1 Click Add-ins Page in the Application Lifecycle Management Options 
window or choose Help > Add-ins Page in the ALM main window. The 
HP Application Lifecycle Management Add-ins page opens.
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The following ALM add-ins are available:

➤ HP Quality Center Connectivity. Enables you to integrate ALM with 
other tools.

➤ HP Quality Center System Test Remote Agent. Enables you to run a 
system test on a machine. You can run a system test to retrieve a 
machine’s system information, view a captured desktop image of a test 
run on a machine, or restart a machine.

➤ HP Sprinter. Provides advanced functionality and a variety of tools to 
assist in the manual testing process. 

➤ More HP ALM Add-ins. Enables you to install additional add-ins. The 
add-ins include integration and synchronization solutions with HP 
and third-party tools.

 2 Click an add-in link. A page with additional information about the add-in 
opens. If you click the More HP ALM Add-ins link, the More HP ALM 
Add-ins page opens, enabling you to select additional add-ins.

 3 Click the add-in guide link (where applicable) for instructions on using 
the add-in.

 4 Click the Download Add-in link to download and install the add-in. 
Follow the instructions on your screen.
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9
Verifying the IIS Configuration

If you encounter a problem in the Internet Information Server (IIS) 
component after you install ALM Platform on Windows, check the IIS 
configuration settings.

This chapter includes: 

➤ Configuring IIS 7.0 on page 127

➤ Configuring IIS 6.0 on page 129

Configuring IIS 7.0

The ALM Platform installation creates the IUSR_<COMPUTER NAME> 
account. IIS uses this account to redirect users from IIS to ALM when they 
open ALM. 

To check the IIS account:

 1 From the Start menu, choose Control Panel > Administrative Tools > 
Internet Information Services (IIS) Manager. The Internet Information 
Services (IIS) Manager window opens.

 2 Expand the tree in the left pane, if needed, and select the directory in 
which your ALM virtual directory is located. This is the IIS Web site that 
was selected during the ALM Platform installation (for example, Default 
Web Site). For more information, see Chapter 2, "Installing 
ALM Platform."

 3 Select the ALM virtual directory (by default, quality_center), and in the 
right pane, click the Authentication icon.
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The Authentication pane contains three methods for setting up the user 
account used by IIS to authenticate user access: Anonymous Authentication, 
Basic Authentication, and Windows Authentication.

➤ Anonymous Authentication.

If Anonymous Authentication is enabled, when a user logs on to 
<ALM Platform server>/qcbin, IIS redirects the connection from IIS to ALM. 

To check or change this account, right-click Anonymous Authentication, 
and select Edit. The user account for IIS anonymous access is 
IUSR_<COMPUTER NAME>.

➤ Windows Authentication.

The Integrated Windows Authentication method is best suited for an 
intranet environment. IIS uses the current Windows user information on 
the client machine to authenticate the user according to the Windows 
domain. 

➤ Basic Authentication.

If Basic authentication is enabled, when a user logs on to <ALM Platform 
server>/qcbin, IIS authenticates the user according to the Windows 
domain. 

To check the Windows domain for basic authentication, right-click Basic 
Authentication, and select Edit. The Edit Basic Authentication Settings 
dialog box opens. If a domain is defined in the Domain Name box, the 
client can access IIS with any user account from that domain. If no 
domain is defined, the local domain is used, and the client can access IIS 
with any local user account.

When basic authentication is enabled, the Web browser transmits user 
accounts across the network in an unencrypted form.
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Configuring IIS 6.0

This sections includes:

➤ "IIS Account Settings" on page 129

➤ "ALM Virtual Directory Settings" on page 131

IIS Account Settings
The ALM Platform installation creates the IUSR_<COMPUTER NAME> 
account. IIS uses this account to redirect users from IIS to ALM when they 
open ALM. 

To check the IIS account:

 1 From the Start menu, choose Control Panel > Administrative Tools > 
Internet Information Services (IIS) Manager. The Internet Information 
Services (IIS) Manager window opens.

 2 Expand the tree in the left pane, if needed, and select the directory in 
which your ALM virtual directory is located. This is the IIS Web site that 
was selected during the ALM Platform installation (for example, Default 
Web Site). For more information, see Chapter 2, "Installing 
ALM Platform."

 3 Right-click the ALM virtual directory (by default, quality_center) and 
choose Properties. The quality_center Properties dialog box opens.

 4 Click the Directory Security tab.

 5 In the Anonymous Access and Authentication Control section, click the 
Edit button. The Authentication Methods dialog box opens.

The Authentication Methods dialog box contains four methods for setting 
up the user account used by IIS to authenticate user access: anonymous 
access, integrated Windows authentication, basic authentication, and .Net 
Passport authentication. 
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➤ Anonymous Access Authentication.

If Enable Anonymous access is selected, when a user logs on to 
<ALM Platform server>/qcbin, IIS redirects the connection from IIS to ALM. 

To check or change this account, click the Anonymous Access Edit 
button. The user account for IIS anonymous access is IUSR_<COMPUTER 
NAME>.

➤ Integrated Windows Authentication.

The Integrated Windows Authentication method is best suited for an 
intranet environment. IIS uses the current Windows user information on 
the client machine to authenticate the user according to the Windows 
domain. 

➤ Basic Authentication.

If Basic authentication is selected, when a user logs on to <ALM Platform 
server>/qcbin, IIS authenticates the user according to the Windows 
domain. 

To check the Windows domain for basic authentication, select the Basic 
authentication check box and click Yes to confirm. Then, click the Basic 
Authentication Edit button. The Basic Authentication Domain dialog box 
opens. If a domain is defined in the Domain Name box, the client can 
access IIS with any user account from that domain. If no domain is 
defined, the local domain is used, and the client can access IIS with any 
local user account.

When basic authentication is selected, the Web browser transmits user 
accounts across the network in an unencrypted form.

➤ .Net Passport Authentication.

When .NET Passport authentication is selected, requests coming into IIS 
must contain .NET Passport credentials either on the query string or 
within a cookie.
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ALM Virtual Directory Settings
Verify that the default virtual directory (by default, quality_center) is 
configured properly. 

To check the configuration for the ALM virtual folders:

 1 From the Start menu, choose Programs > Administrative Tools > Internet 
Information Services (IIS) Manager. The Internet Information Services 
(IIS) Manager window opens.

 2 Expand the tree in the left pane, if needed, and select the directory in 
which your ALM virtual directory is located. This is the IIS Web site that 
was selected during the ALM Platform installation (for example, Default 
Web Site). For more information, see Chapter 2, "Installing 
ALM Platform."

 3 Right-click the ALM virtual directory (by default, quality_center) and 
choose Properties. The quality_center Properties dialog box opens. In the 
Virtual Directory tab, verify that the following options are set:

➤ Read is selected.

➤ Script source access, Write, and Directory browsing are cleared.

➤ The Application name box is enabled and the Remove button is 
visible.

➤ Scripts and Executables is selected in the Execute Permissions list.

➤ DefaultAppPool is selected in the Application Protection list.

 4 Click OK to close the quality_center Properties dialog box.
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10
Customizing ALM

You can customize various aspects of HP Application Lifecycle Management 
(ALM), by creating or configuring system files.

This chapter includes: 

➤ Customizing the SA Repository and Application on page 133

➤ Customizing Module Names and Menus on page 135

Customizing the SA Repository and Application

Customization of the Site Administration repository and the qcbin 
application must be performed in the ALM Platform deployment directory. 
For example, if you edit .xsl mail stylesheets, or create custom test types. 
After customizing any of the files in the deployment directory, you must 
redeploy ALM.

Caution: You must not modify, add, or delete files in the ALM Platform 
installation directory.

This section includes:

➤ Customizing the Site Administration Repository

➤ Customizing the qcbin Application
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Customizing the Site Administration Repository
Perform the following procedure to customize the Site Administration 
repository. 

To customize the Site Administration repository:

 1 On the ALM Platform machine, open a file browser, and navigate to  
<ALM installation path>\data\sa.

 2 Open another file browser, and navigate to 
<ALM repository path>\customerData.

 3 In the installation directory, navigate to the file that you want to 
customize.

 4 In the repository directory, under customerData, create the same folder 
structure that contains the file in the installation directory.

 5 Copy the file from the installation directory, and paste the file in the 
appropriate folder in the repository directory.

 6 Edit the file in the repository directory.

 7 Run the Server Deployment Wizard:

On Windows systems: Choose one of the following:

➤ Start > HP ALM Platform > Server Deployment Wizard

➤ <installation path>\bin\run_server_deploy_tool.bat

On Unix systems: <installation path>/bin/run_server_deploy_tool.sh

Customizing the qcbin Application
Perform the following procedure to customize the qcbin application.

To customize the qcbin application:

 1 On the ALM Platform machine, open a file browser, and navigate to  
<ALM installation path>\application\20qcbin.war.

 2 Open another file browser, and navigate to 
<ALM deployment path>\application\20qcbin.war.

 3 In the installation directory, navigate to the file that you want to 
customize.
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 4 In the deployment directory, under 20qcbin.war, create the same folder 
structure that contains the file in the installation directory.

 5 Copy the file from the installation directory, and paste the file in the 
appropriate folder in the deployment directory.

 6 Edit the file in the deployment directory.

 7 Run the Server Deployment Wizard:

On Windows systems: Choose one of the following:

➤ Start > HP ALM Platform > Server Deployment Wizard

➤ <installation path>\bin\run_server_deploy_tool.bat

On Unix systems: <installation path>/bin/run_server_deploy_tool.sh

 8 If you use a WebLogic or WebSphere application server, manually deploy 
the updated war file from the <deployment path>\deployment folder. 
For more information, see Chapter 4, "Deploying ALM Platform on 
WebLogic," or Chapter 5, "Deploying ALM Platform on WebSphere."

 9 Repeat the procedure on each cluster node.

Customizing Module Names and Menus

You can customize the names of the Application Lifecycle Management 
modules, and the Tools and Help menus, by modifying the 
ALM-Client.exe.config file on the ALM Platform machine.

To customize ALM:

 1 On the ALM Platform machine, extract the ALM-Client.exe.config file 
from Client.cab. This file is located in: 

For JBoss users: 
<ALM deployment path>\jboss\server\default\deploy\20qcbin.war\
Install

For other application server users: 
<ALM deployment path>\deployment\20qcbin.war\Install

 2 Open the ALM-Client.exe.config file (this is in .xml format).
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 3 To delete ALM modules or rearrange their order, locate the <Modules> 
section of the file, and delete or move the selected module section as 
required.

Note: To customize a module name, add the REPLACE_TITLE parameter in 
the Site Configuration tab in Site Administration. For more information, 
refer to the HP Application Lifecycle Management Administrator Guide.

 4 You can change or delete the Document Generator item in the Tools 
menu. This is defined in the Tools section of the file. In the same section, 
you can also add new items to the Tools menu.

The following is the syntax of an entry in the Tools line:

 5 To change, delete, or rearrange the list of items in the Help menu, change 
the default names, IDs, and URLs listed in the OnlineHelpItem line. The 
following is the syntax of an entry in the OnlineHelpItem line:

To create a separator line between two items in the Help menu, use the 
following syntax:

<TDFrame
      Tools="<Tool_Name>,{<Tool_ID>}"
      Workflow="{<Workflow_ID>}"
      Parameters="<parameters>"
 />

<OnlineHelpItem 
ID="<Help_ID>" 
Name="<Help_Name>" 
Url="<Help_URL>" 

<OnlineHelpItem 
ID="<Help_ID>" 
Name="<Help_Name>" 
Url="<Help_URL>" 
IsFirstInGroup="true" />
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Note: The first two menu items in the Help menu, Help on this page and 
Documentation Library, and the last Help menu item, 
About HP Application Lifecycle Management Software, cannot be moved 
or changed. They do not have corresponding entries in the 
QualityCenter.exe.config file. The above step only affects the menu items 
between them.

 6 Unzip the Client.cab file to a temporary folder named Client which must 
be under the temp folder. For example, C:\temp\Client.

 7 Replace the ALM-Client.exe.config file with the modified file.

 8 Store the temporary folder on a logical drive, for example X, by running 
the following command:

For example, subst X: C:\temp

 9 Create a new Client.cab file with the command:

Note: To use this command you must first download cabsdk.exe (the 
Cabinet Software Development Kit) from the Microsoft Download Center.

 10 Add a class 3 digital signature to the new Client.cab file.

Note: The digital signature must be a signature of a trusted provider.

subst [X]: <temp folder>

cabarc -r -p -P Client\ -s 6144 N <temp folder>\Client.cab X:\Client\*.*
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 11 Under <ALM deployment path>\application\20qcbin.war, create a new 
Installation folder, if it does not already exist.

 12 Save the new cab file under the Installation folder.

 13 Run the Server Deployment Wizard:

On Windows systems: Choose one of the following:

➤ Start > HP ALM Platform > Server Deployment Wizard

➤ <installation path>\bin\run_server_deploy_tool.bat

On Unix systems: <installation path>/bin/run_server_deploy_tool.sh

 14 If you use a WebLogic or WebSphere application server, manually deploy 
the updated war file from the <ALM deployment path>\deployment 
folder. For more information, see Chapter 4, "Deploying ALM Platform on 
WebLogic," or Chapter 5, "Deploying ALM Platform on WebSphere."

 15 Repeat the procedure on each cluster node.
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11
Changing the JBoss Heap Memory Size 
and Port

After installing ALM Platform, you can update the heap memory value on 
the JBoss application server if there is a change in the number of active 
projects or concurrent user sessions in ALM Platform. You can also change 
the JBoss default port number.

This chapter includes: 

➤ Changing the JBoss Heap Memory Size on page 139

➤ Changing JBoss Port Numbers on page 143

Changing the JBoss Heap Memory Size

If you select JBoss as the application server during the ALM Platform 
installation, you can specify the memory heap value that is used by the 
JBoss server, or accept the default value (1024-1536 MB).

After you install ALM Platform, you may need to change the JBoss heap 
memory values. For example, you may want to increase the JBoss heap size 
if there is an increase in the number of active projects in ALM Platform, or 
an increase in the number of concurrent user sessions.

Note: The maximum JBoss heap value cannot exceed your maximum 
memory (RAM) size.
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This section includes the following topics:

➤ Changing the JBoss Heap Size on Windows

➤ Changing the JBoss Heap Size on Unix Systems

Changing the JBoss Heap Size on Windows
You can change the JBoss heap memory size on Windows server machines 
by uninstalling the ALM Platform service, modifying the heap size in the 
InstallJbossService.bat file, and reinstalling the ALM Platform service. You 
also need to modify the run.bat file to make sure that it is synchronized 
with the service.

To change the JBoss heap memory size on Windows:

 1 Verify that all users have logged out from ALM projects, and stop the 
ALM Platform service.

 2 Open Command Prompt, and navigate to the 
<deployment_path>\jboss\bin folder. By default, the deployment path is 
(on Windows 2008): C:\Users\All Users\HP\ALM

 3 To uninstall the existing service, run the following command:

 4 To change the JVM memory allocation, perform the following:

 a Open the InstallJbossService.bat file, and modify the heap and perm 
size parameter as required. For example, if the heap memory is 
currently 1024 MB: 

you can increase the heap size to 1536 MB as follows:

 b Save and close the InstallJbossService.bat file.

InstallJbossService.bat -uninstall

set JAVA_OPTS=%JAVA_OPTS% -Xms1024m -Xmx1024m 
-XX:MaxPermSize=256m

set JAVA_OPTS=%JAVA_OPTS% -Xms1536m -Xmx1536m 
-XX:MaxPermSize=256m
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 5 To reinstall the service with the modified heap size parameter, perform 
the following:

 a Run the following command:

 b From the Start menu, choose Control Panel > Administrative Tools > 
Services, and verify that the service has been installed.

 c Start the HP ALM Platform service.

 d Check that the specified heap size is shown as total memory. Open 
your Web browser, and type the following URL:

http://<ALM Platform server name>:<port number>/qcbin/debug

Note: If you are working with cluster nodes, the ALM Platform server 
name should be the node machine name, and you must perform the 
above steps on each node. 

 6 To modify the run.bat file, perform the following:

 a Navigate to the <deployment_path>\jboss\bin folder.

 b In the run.bat file, change the heap size so that it is synchronized with 
the heap size changes you made in the InstallJbossService.bat file.

 c Save and close the run.bat file.

InstallJbossService.bat -c "default"
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Changing the JBoss Heap Size on Unix Systems
You can change the JBoss heap memory size on Unix systems by modifying 
the run.sh file.

To change the JBoss heap memory size on Unix systems:

 1 Navigate to the <deployment_path>/jboss/bin folder. By default, the 
deployment path is: /var/opt/HP/ALM

 2 To change the JVM memory allocation, perform the following:

 a Open the run.sh file, and modify the heap and perm size parameter as 
required. For example, if the heap memory is currently 1024 MB: 

you can increase the heap size to 1536 MB as follows:

 b Save and close the run.sh file.

 3 Verify that all users have logged out from ALM projects, and restart the 
ALM Platform service by running:

 a run.sh stop.

 b run ps –ef | grep java (to make sure that the JBoss server has stopped)

 c run.sh start

JAVA_OPTS="$JAVA_OPTS -Xms1024m -Xmx1024m  
-XX:MaxPermSize=256m"

JAVA_OPTS="$JAVA_OPTS -Xms1536m -Xmx1536m  
-XX:MaxPermSize=256m"
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 4 Check that the specified heap size is shown as total memory. Open your 
Web browser, and type the following URL:

http://<ALM Platform server name>:<port number>/qcbin/debug

Note: If you are working with cluster nodes, the ALM Platform server 
name should be the node machine name, and you must perform the 
above steps on each node.

Changing JBoss Port Numbers

After you install ALM Platform, you may need to change the port number 
on the JBoss application server, if the port has been reserved or is already in 
use. You can change the port by updating the port number in the server.xml 
file.

If you are using JBoss as your application server and as your Web server, the 
port number is shared, so you only need to change the port number on the 
application server. If the IIS Web server is installed on your machine, you 
must also change the port number on the IIS Web server.

You must also update the port number in the qcConfigFile.properties file.



Chapter 11 • Changing the JBoss Heap Memory Size and Port

144

To change the port number on the JBoss application server:

 1 Change the port number in the server.xml file.

 a Navigate to <deployment_path>\jboss\server\default\
deploy\jbossweb.sar, and open the server.xml file in a text editor. 

 b Change the port number. For example, if Connector port="8080", you 
can change it to Connector port="8081".

 2 Stop the JBoss application server. For more information on stopping and 
starting JBoss, see "Starting and Stopping ALM Platform Services" on 
page 115.

 3 Restart JBoss.

 4 Log in to ALM using the new port number.

To change the port number on the IIS Web server:

 1 From the Start menu, choose Programs > Administrative Tools > Internet 
Information Services (IIS) Manager. The Internet Information Services 
(IIS) Manager window opens.

 2 Expand the tree in the left pane, and stop the default Web site by right-
clicking Default Web Site, and selecting Stop. The service is marked 
(Stopped).

 3 Right-click Default Web Site and select Properties.

 4 Click the Web Site tab, change the port number in the TCP Port box, and 
click OK.

 5 To restart the default Web site, right-click Default Web Site, and select 
Start.

 6 When you open ALM, type the new port number in your ALM URL: 
http://<ALM Platform server name>:<port number>/qcbin

For example, if you changed the port from 8080 to 8081 on server Lab1, 
type: http://Lab1:8081/qcbin
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To update the port number in the qcConfigFile.properties file:

 1 Open the qcConfigFile.properties file. The file is saved in the following 
path: <ALM Platform deployment path>/HP/ALM/conf

 2 Update the port number in the jbossPort line.

 3 If you use a JBoss Web server, update also the webServerPort line.

Changing Ports Used by JBoss Internal Processes

JBoss uses the following default ports for its internal processes: 1090, 1098, 
1099, 4444, 4445, 4446, 4712, 4713, 8009, 8083.

If the ports are already in use by other processes, you can either release the 
the ports, or change the ports that JBoss uses.

To change ports used by JBoss internal processes:

 1 Navigate to <deployment_path>\jboss\server\default\conf\ 
bindingservice.beans\META-INF, and open the bindings-jboss-beans.xml 
file in a text editor.

 2 Change port numbers as required.

 3 Stop the JBoss application server. For more information on stopping and 
starting JBoss, see "Starting and Stopping ALM Platform Services" on 
page 115.

 4 Restart JBoss.
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12
Uninstalling ALM Platform

You can uninstall ALM Platform from your server machine. When 
uninstalling ALM Platform, projects are not deleted. You can also uninstall 
ALM components from a workstation that has been used to access 
Application Lifecycle Management.

This chapter includes:

➤ Uninstalling ALM Platform from Windows on page 147

➤ Uninstalling ALM Platform from Unix Platforms on page 148

➤ Uninstalling ALM Components from a Workstation on page 148

Uninstalling ALM Platform from Windows

This section describes how to uninstall ALM Platform from your Windows 
server machine. 

To uninstall ALM Platform from Windows:

 1 Make sure that the application server is running.

 2 To open the HP ALM Platform Uninstall Wizard, you can:

➤ Choose Control Panel > Add/Remove Programs, select 
HP ALM Platform, and click the Change/Remove button. Follow the 
instructions on your screen.

➤ Locate the ALM Platform home directory ([drive]:\HP\ALM-Platform). In 
the _uninst subdirectory, double-click uninstall.exe.

 3 Click Next. Follow the instructions on your screen.
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Uninstalling ALM Platform from Unix Platforms

This section describes how to uninstall ALM Platform from your Unix server 
machine.

Note: To uninstall ALM Platform, use the same user that installed 
ALM Platform.

To uninstall ALM Platform from Unix platforms:

 1 Make sure that the application server is running.

 2 Type the following command at the system prompt:

The HP ALM Platform Uninstall wizard opens.

 3 Click Next. Follow the instructions on your screen.

Uninstalling ALM Components from a Workstation

When you run ALM on your client computer, client components are 
downloaded to your workstation. You can use the client uninstall utility to 
remove all ALM client components, including files and registry keys. To 
download the utility, see HP Software Self-solve knowledge base article 
KM176290 (http://h20230.www2.hp.com/selfsolve/document/KM176290). 

If the workstation is used to access ALM after the utility has been run, all 
necessary components are downloaded from the ALM Platform server.

/[directory]/[ALM_Platform_deployment_directory]/_uninst/uninstall.bin

http://h20230.www2.hp.com/selfsolve/
document/KM176290
http://h20230.www2.hp.com/selfsolve/
document/KM176290
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A
Troubleshooting ALM Platform 
Installation

This chapter contains troubleshooting suggestions for issues relating to the 
ALM Platform installation.

This chapter includes:

➤ Disabling Validation Checks for the Configuration Wizard on page 150

➤ Checking the Installation and Configuration Log Files on page 153

➤ ALM Platform Installation Already Exists on page 154

➤ Database Validator Fails on page 155

➤ IIS Site Not Responding on page 156

➤ ALM Service Does Not Start on page 157

➤ JBoss Does Not Start on page 157
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Disabling Validation Checks for the Configuration Wizard

The ALM Platform Configuration Wizard automatically performs validation 
checks to verify that particular system configurations requirements are met. 
If ALM Platform configuration does not complete due to a failed validation, 
you can disable selected validation checks and rerun the ALM Platform 
Configuration Wizard.

Caution: You should disable validation checks only if you are sure that the 
validation result is wrong.

Notes:

➤ To resolve failures that occur during the ALM Platform Installation 
Wizard, see "Checking the Installation and Configuration Log Files" on 
page 153, or "ALM Platform Installation Already Exists" on page 154.

➤ For troubleshooting tips on database validations, see "Database Validator 
Fails" on page 155.

To disable configuration validators and rerun the ALM Platform 
Configuration Wizard:

 1 In the ALM Platform installation directory, open the run_after_finish.bat 
or run_after_install.sh file for editing.

Tip: On Windows, you can access the file from Start > Programs > 
HP ALM Platform > Server Configuration Wizard.
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 2 Locate the rem set SKIP_VALIDATIONS line, and do the following:

 a Remove the rem command.

 b After the equal sign, add one or more of the arguments to disable 
selected validations. For example, to disable the JBoss user validation, 
the line should be as follows:

set SKIP_VALIDATIONS=-wJbossUserValidator

For a complete list of validators and their descriptions, see 
"Configuration Validators" on page 151.

 3 Save and close the file.

 4 Run the file.

Configuration Validators

Validator Checks To disable

Operating 
system and 
license

Checks that the operating system 
is supported.

-wOsValidator

Existing 
installation

Checks if an older version of 
ALM Platform or Quality Center 
is installed. For troubleshooting 
tips, see "ALM Platform 
Installation Already Exists" on 
page 154.

-wPreviousInstallationValidator

License file Checks license file key. -wLicenseTypeValidator

Security 
passphrases

Checks encryption passphrases. -wEncryptionStepValidator

Mail server Checks that the mail server name 
is valid.

-wMailServerValidator

JBoss settings Checks if JBoss can be installed 
with the defined settings.

-wJbossValidator

JBoss user Checks if the JBoss user exists and 
has the required permissions.

-wJbossUserValidator
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Database 
connectivity

Checks database connectivity. -wDbSettingsStepValidator

Database 
settings

Checks Site Administration 
database settings.

-wSaSchemaValidator

Site 
administrator

Checks site administrator user 
settings.

-wSiteAdminUserValidator

Repository 
folder

Checks that the repository folder 
is accessible, and has sufficient 
space.

-wRepositoryValidator

Validator Checks To disable
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Checking the Installation and Configuration Log Files

If you encounter problems installing ALM Platform, check for errors in the 
following log files:

Unix File Delivery Logs

Windows File Delivery Logs

Application Logs

Log Path

Native package 
installation log

/var/log/<date>_HP_ALM_Platform.ALMPlatform_
install_log.txt

Installation sequencer 
wizard log

/var/log/<date>_HP_ALM_Platform_11.00.000_iHP_log

Prerequisites log /var/log/<date>_HP_ALM_Platform_11.00.000_
prerequisites_iHP_log.txt

Log Path

Custom actions logs %temp%\ihp_custom_batches.log

%temp%\iHP.Runtime.CustomActions.HP_Application_
Lifecycle_Management_Platform.log

Log Path

Configuration logs Windows 2003: C:\Documents and Settings\All 
Users\Application Data\HP\ALM\log

Windows 2008: C:\Users\All Users\HP\ALM\log

Unix: C:\var\opt\HP\ALM\log

Schema creation logs <ALM Platform deployment folder>\log\sa

JBoss server logs <ALM Platform deployment folder>\jboss\server
\default\log
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ALM Platform Installation Already Exists

If during installation, an error message displays that an ALM Platform 
installation already exists, you should verify that ALM Platform is not 
installed, and that there are no traces of an old installation.

To verify that ALM Platform is not installed:

 1 From the Start menu, choose Control Panel > Add/Remove Programs.

 2 In the program list, check for HP Quality Center or HP Application 
Lifecycle Management Platform.

 3 If either appears in the program list, click Remove, and follow the 
instructions on your screen.

 4 After you uninstall ALM Platform, check that the 
<ALM Platform home>\application directory was deleted. If it was not 
deleted, delete the directory before you install ALM Platform.

To remove traces of an old ALM Platform installation:

 1 Navigate to the system root (%systemroot%) directory (on Unix systems, 
go to the /home directory).

 2 Make a backup of the vpd.properties file.

 3 In a text editor, open the vpd.properties file and delete any lines that 
mention ALM Platform.
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Database Validator Fails

During ALM Platform configuration, if the database validator fails, perform 
the following checks:

➤ Check that the input parameters are correct.

➤ Check that the Site Administration schema name was provided.

➤ If upgrading a Microsoft SQL Server site schema, check whether the same 
authentication type was used as the one used in the previous installation.

To check whether the parameters are correct:

 1 Read the error message that displays during installation, and try to 
understand and resolve the problem from the root cause.

 2 For further clarifications, check with your database administrator.

 3 If no error was found and you are sure that the parameters are correct, 
disable the DB parameters validator as described in "Disabling Validation 
Checks for the Configuration Wizard" on page 150.

To check that the Site Administration schema name was provided:

 1 Open a database query tool.

 2 Make sure the PROJECTS table exists in the schema. This table exists in 
the Site Administration schema only and not in the project schema.

To check the SQL authentication type of a previous installation (when 
upgrading an SQL Server site schema):

 1 Navigate to the ALM Platform home directory, and open the \application 
folder. By default, the home directory is C:\Program Files\HP\
ALM Platform on Windows, and /opt/HP/HP_ALM_Platform on Unix 
systems.

 2 Extract the contents of qcbin.war into a temp file, and open the 
siteadmin.xml file in a text editor.

 3 Search for the “native” property. If its value is set to “Y”, Windows 
authentication was used. Make sure that the new installation uses the 
same authentication type (Microsoft SQL Server authentication or 
Windows authentication) as the previous installation.
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IIS Site Not Responding

If you are using an IIS Web server and a message displays that the IIS site is 
not responding, verify that JBoss is running and that IIS was configured 
successfully.

To verify that JBoss is running:

 1 Wait approximately 20 minutes in case the machine is slow, or JBoss and 
IIS are running slowly.

 2 Open your Web browser and type your JBoss URL. By default, this is 
http://localhost:8080/qcbin.

 3 Check if the ALM Welcome page is displayed.

If the Welcome page is displayed, the problem is within IIS. 

If the Welcome page is not displayed, the problem is within JBoss. Follow 
the steps described in "JBoss Does Not Start" on page 157.

To check the IIS configuration:

 1 Open the IIS manager (choose Start > Run, and type inetmgr).

 2 Select the Web site that was selected during installation. The default Web 
site used during installation is Default Web Site. For more information on 
selecting the IIS Web site, see step 21 on page 73.

 3 Check that the Web site contains a folder named quality_center. If there is 
no quality_center folder, you must reconfigure ALM Platform.

 4 Select the Default Web Site directory, click Properties the ISAPI Filters 
icon.

 5 Check that the quality_center folder is listed as a filter. If the filter is not 
enabled, reconfigure ALM Platform.

 6 For IIS 6.0, click the Web Service Extensions folder, and make sure that 
the QC extension exists and is allowed.

If the QC extension is not allowed, select QC and click Allow.

If the QC extension does not exist, select All unknown ISAPI extensions 
and click Allow.
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ALM Service Does Not Start

Problem: On a Windows 2003 system, the HP Application Lifecycle 
Management service does not start.

Reason: The file mscvr71.dll cannot be located by the Java Virtual Machine. 
This is due to changes in Microsoft’s policy concerning DLLs. For more 
information, see: http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/vclib/html/_CRT_C_Run.2d.Time_Libraries.asp

Solution: Choose one of the following:

➤ In Environment Variables, under System variables, add to the Path 
variable the path %JAVA_HOME%\bin.

➤ Copy %JAVA_HOME%\bin\mscvr71.dll to any of the folders defined in 
the Path variable.

➤ Copy %JAVA_HOME%\bin\mscvr71.dll to 
%ALLUSERSPROFILE%\Application Data\HP\ALM\jboss\bin.

JBoss Does Not Start

If you are using a JBoss application server, and a message displays that JBoss 
does not start, perform the following checks:

➤ Check memory allocation.

➤ Check that JBoss works.

➤ Check the JBoss service user.

➤ Check that there are no JBoss script errors.

To check memory allocation:

 1 Check that a JBoss boot log is created. The log is located in 
<Deployment folder>\jboss\server\default\log\boot.log.

If no log is created, it is likely that the service could not start due to a 
memory allocation problem.

 2 Confirm that the problem is related to memory allocation, by running 
the run.bat script, located under <Deployment folder>\jboss\bin\run.bat

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/vclib/html/_CRT_C_Run.2d.Time_Libraries.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/vclib/html/_CRT_C_Run.2d.Time_Libraries.asp
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If the problem is related to memory allocation, JBoss will not start, and an 
error message states that JVM could not allocate the defined heapsize.

 3 To solve the memory allocation problem, change the JBoss memory 
settings until JBoss starts. For more information, see "Changing the JBoss 
Heap Memory Size" on page 139.

To check JBoss works:

 1 Wait about 20 minutes in case the machine is slow, or JBoss and IIS are 
working slowly.

 2 Open your Web browser and type your JBoss URL. By default, this is 
http://localhost:8080/qcbin.

 3 Check if the ALM Welcome page is displayed.

If the Welcome page is not displayed, the problem is within JBoss. Check 
the other JBoss troubleshooting options.

To check the JBoss service user:

 1 Open the Services control panel (choose Start > Run, and type 
services.msc).

 2 Right-click the HP Application Lifecycle Management service, and click 
Properties.

 3 Click the Log On tab.

 4 Enter the user information and restart the service.

To check if the JBoss script has an error:

 1 Run Jboss manually. Open the command window, (choose Start > Run, 
and type cmd).

 2 Change the folder to <ALM Platform deployment folder>/jboss/bin.

 3 Run run.bat.

 4 Check if there are any errors.
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B
LW-SSO Authentication – General 
Reference

This chapter contains information relating to Lightweight Single Sign-On 
(LW-SSO) Authentication.

This chapter includes:

➤ LW-SSO Authentication Overview on page 159

➤ LW-SSO System Requirements on page 161

➤ LW-SSO Security Warnings on page 162

➤ Troubleshooting and Limitations on page 164

LW-SSO Authentication Overview

LW-SSO is a method of access control that enables a user to log on once and 
gain access to the resources of multiple software systems without being 
prompted to log on again. The applications inside the configured group of 
software systems trust the authentication, and there is no need for further 
authentication when moving from one application to another.

The information in this section applies to LW-SSO version 2.2 and 2.3.

LW-SSO Token Expiration
The LW-SSO Token's expiration value determines the application's session 
validity. Therefore, its expiration value should be at least the same value as 
that of the application session expiration value.
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Recommended Configuration of the LW-SSO Token 
Expiration
Each application using LW-SSO should configure token expiration. The 
recommended value is 60 minutes. For an application that does not require 
a high level of security, it is possible to configure a value of 300 minutes.

GMT Time
All applications participating in an LW-SSO integration must use the same 
GMT time with a maximum difference of 15 minutes.

Multi-domain Functionality
Multi-domain functionality requires that all applications participating in 
LW-SSO integration configure the trustedHosts settings (or the 
protectedDomains settings), if they are required to integrate with 
applications in different DNS domains. In addition, they must also add the 
correct domain in the lwsso element of the configuration.

Get SecurityToken for URL Functionality
To receive information sent as a SecurityToken for URL from other 
applications, the host application should configure the correct domain in 
the lwsso element of the configuration.
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LW-SSO System Requirements

The following table lists LW-SSO configuration requirements:

Application Version Comments

Java 1.5 and higher

HTTP Servlets API 2.1 and higher

Internet Explorer 6.0 and higher Browser should enable HTTP 
session cookie and HTTP 302 
Redirect functionality

FireFox 2.0 and higher Browser should enable HTTP 
session cookie and HTTP 302 
Redirect functionality

JBoss Authentica-
tions

JBoss 4.0.3

JBoss 4.3.0

Tomcat Authentica-
tions

Standalone Tomcat 
5.0.28 

Standalone Tomcat 
5.5.20 

Acegi Authentica-
tions 

Acegi 0.9.0 

Acegi 1.0.4 

Spring Security 
Authentication

Spring Security 2.0.4

Web Services 
Engines 

Axis 1 - 1.4 

Axis 2 - 1.2 

JAX-WS-RI 2.1.1
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LW-SSO Security Warnings

This section describes security warnings that are relevant to the LW-SSO 
configuration:

➤ Confidential InitString parameter in LW-SSO. LW-SSO uses Symmetric 
Encryption to validate and create a LW-SSO token. The initString 
parameter within the configuration is used for initialization of the secret 
key. An application creates a token, and each application using the same 
initString parameter validates the token.

Caution: 

➤ It is not possible to use LW-SSO without setting the initString 
parameter.

➤ The initString parameter is confidential information and should be 
treated as such in terms of publishing, transporting, and persistency.

➤ The initString parameter should be shared only between applications 
integrating with each other using LW-SSO.

➤ The initString parameter should have a minimum length of 12 
characters.

➤ Enable LW-SSO only if required. LW-SSO should be disabled unless it is 
specifically required.

➤ Level of authentication security. The application that uses the weakest 
authentication framework and issues a LW-SSO token that is trusted by 
other integrated applications determines the level of authentication 
security for all the applications.

It is recommended that only applications using strong and secure 
authentication frameworks issue an LW-SSO token. 
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➤ Symmetric encryption implications. LW-SSO uses symmetric 
cryptography for issuing and validating LW-SSO tokens. Therefore, any 
application using LW-SSO can issue a token to be trusted by all other 
applications sharing the same initString parameter. This potential risk is 
relevant when an application sharing an initString either resides on, or is 
accessible from, an untrusted location.

➤ User mapping (Synchronization). The LW-SSO framework does not 
ensure user mapping between the integrated applications. Therefore, the 
integrated application must monitor user mapping. We recommend that 
you share the same user registry (as LDAP/AD) among all integrated 
applications. 

Failure to map users may cause security breaches and negative application 
behavior. For example, the same user name may be assigned to different 
real users in the various applications.

In addition, in cases where a user logs onto an application (AppA) and 
then accesses a second application (AppB) that uses container or 
application authentication, the failure to map the user will force the user 
to manually log on to AppB and enter a user name. If the user enters a 
different user name than was used to log on to AppA, the following 
behavior can arise: If the user subsequently accesses a third application 
(AppC) from AppA or AppB, then they will access it using the user names 
that were used to log on to AppA or AppB respectively.

➤ Identity Manager. Used for authentication purposes, all unprotected 
resources in the Identity Manager must be configured with the 
nonsecureURLs setting in the LW-SSO configuration file. 
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Troubleshooting and Limitations

Known Issues
This section describes known issues for LW-SSO authentication.

➤ Security context. The LW-SSO security context supports only one 
attribute value per attribute name.

Therefore, when the SAML2 token sends more than one value for the 
same attribute name, only one value is accepted by the LW-SSO 
framework.

Similarly, if the IdM token is configured to send more than one value for 
the same attribute name, only one value is accepted by the LW-SSO 
framework.

➤ Multi-domain logout functionality when using Internet Explorer 7. Multi-
domain logout functionality may fail when the browser used is Internet 
Explorer 7 and the application is invoking more than three consecutive 
HTTP 302 redirect verbs in the logout procedure.

In this case, Internet Explorer 7 may mishandle the HTTP 302 redirect 
response and display an Internet Explorer cannot display the webpage 
error page instead.

As a workaround, it is recommended to reduce, if possible, the number of 
application redirect commands in the logout sequence.

Limitations
Note the following limitations when working with LW-SSO authentication:

➤ Client access to the application. 

If a domain is defined in the LW-SSO configuration:

➤ The application clients must access the application with a Fully 
Qualified Domain Name (FQDN) in the login URL, for example, 
http://myserver.companydomain.com/WebApp. 

➤ LW-SSO cannot support URLs with an IP address, for example, 
http://192.168.12.13/WebApp.
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➤ LW-SSO cannot support URLs without a domain, for example, 
http://myserver/WebApp.

If a domain is not defined in the LW-SSO configuration: The client can 
access the application without a FQDN in the login URL. In this case a 
LW-SSO session cookie is created specifically for a single machine without 
any domain information. Therefore, the cookie is not delegated by the 
browser to another, and does not pass to other computers located in the 
same DNS domain. This means that LW-SSO does not work in the same 
domain.

➤ LW-SSO framework integration. Applications can leverage and use 
LW-SSO capabilities only if integrated within the LW-SSO framework in 
advance. 

➤ Multi-Domain Support.

➤ Multi-domain functionality is based on the HTTP referrer. Therefore, 
LW-SSO supports links from one application to another and does not 
support typing a URL into a browser window, except when both 
applications are in the same domain.

➤ The first cross domain link using HTTP POST is not supported.

Multi domain functionality does not support the first HTTP POST 
request to a second application (only the HTTP GET request is 
supported). For example, if your application has an HTTP link to a 
second application, an HTTP GET request is supported, but an HTTP 
FORM request is not supported. All requests after the first can be either 
HTTP POST or HTTP GET.

➤ LW-SSO Token size:

The size of information that LW-SSO can transfer from one application 
in one domain to another application in another domain is limited to 
15 Groups/Roles/Attributes (note that each item may be an average of 
15 characters long). 
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➤ Linking from Protected (HTTPS) to non-protected (HTTP) in a multi-
domain scenario: 

Multi domain functionality does not work when linking from a 
protected (HTTPS) to a non-protected (HTTP) page. This is a browser 
limitation where the referrer header is not sent when linking from a 
protected to a non-protected resource. For an example, see: 
http://support.microsoft.com/support/kb/articles/Q178/0/66.ASP

➤ Third-Party cookie behavior in Internet Explorer: 

Microsoft Internet Explorer 6 contains a module that supports the 
"Platform for Privacy Preferences (P3P) Project," meaning that cookies 
coming from a Third Party domain are by default blocked in the 
Internet security zone. Session cookies are also considered Third Party 
cookies by IE, and therefore are blocked, causing LW-SSO to stop 
working. 

To solve this issue, add the launched application (or a DNS domain 
subset as *.mydomain.com) to the Intranet/Trusted zone on your 
computer (in Microsoft Internet Explorer, select Menu > Tools > 
Internet Options > Security > Local Intranet > Sites > Advanced), 
which causes the cookies to be accepted. 

Caution: The LW-SSO session cookie is only one of the cookies used by 
the Third Party application that is blocked. 

➤ SAML2 token.

➤ Logout functionality is not supported when the SAML2 token is used.

Therefore, if the SAML2 token is used to access a second application, a 
user who logs out of the first application is not logged out of the 
second application.

➤ The SAML2 token's expiration is not reflected in the application's 
session management.

Therefore, if the SAML2 token is used to access a second application, 
each application's session management is handled independently.

http://support.microsoft.com/support/kb/articles/Q178/0/66.ASP
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➤ JAAS Realm. The JAAS Realm in Tomcat is not supported.

➤ Using spaces in Tomcat directories. Using spaces in Tomcat directories is 
not supported.

It is not possible to use LW-SSO when a Tomcat installation path (folders) 
includes spaces (for example, Program Files) and the LW-SSO 
configuration file is located in the common\classes Tomcat folder.

➤ Load balancer configuration. A load balancer deployed with LW-SSO 
must be configured to use sticky sessions. For details about sticky sessions, 
see CREATE_HTTP_SESSION in the HP Application Lifecycle Management 
Administrator Guide.



Chapter B • LW-SSO Authentication – General Reference

168



 




	HP Application Lifecycle Management Installation Guide
	Table of Contents
	Welcome to This Guide
	How This Guide is Organized
	Documentation Library
	Documentation Library Guides
	Additional Online Resources

	Before You Install
	About the ALM Platform Technology
	The Installation Process
	Verify System Configurations
	Upgrade Projects
	Install ALM Platform
	Start Application Lifecycle Management
	Customize and Configure ALM
	Install Performance Center Server and Components

	Application Lifecycle Management Editions
	Installation Checklist
	ALM Platform Prerequisites
	System Configurations
	Permissions Required to Install ALM Platform
	License File and Maintenance Key
	Clustering Configuration
	Security Passphrases
	Application Server Information
	Web Server Information
	Mercury Tours Web Application and ALM Demo Project
	Mail Server Information
	Database Prerequisites for Oracle
	Oracle RAC Support
	Database Prerequisites for Microsoft SQL
	Site Administration Login Credentials
	ALM Platform Repository Path

	ALM Client-Side Prerequisites
	System Configurations
	Permissions Required to Download ALM Client
	Internet Explorer Configuration

	Upgrading Projects and Database Schemas
	Upgrading Projects from Previous Versions and Editions
	Upgrading Version Control
	Upgrading Existing Schema


	Installing ALM Platform
	About Installing ALM Platform
	Mounting the File System Repository in a Clustered Environment
	Installing ALM Platform
	Installing ALM Platform in Silent Mode
	Configuring the IIS Mail Service

	Installing Quality Center Starter Edition
	Deploying ALM Platform on WebLogic
	Deploying ALM Platform on WebLogic
	Undeploying ALM Platform on WebLogic

	Deploying ALM Platform on WebSphere
	Deploying ALM Platform on WebSphere
	Undeploying ALM Platform on WebSphere

	Integrating JBoss with Apache
	About Integrating JBoss with Apache
	Integrating JBoss with Apache on Windows
	Integrating JBoss with Apache on Unix Platforms
	Apache-JBoss Integration Configuration Files

	Getting Started
	Browsing the ALM Platform Program Folder
	Starting and Stopping ALM Platform Services
	Starting Application Lifecycle Management
	Registering ALM on a Workstation
	Permissions Required to Register ALM on a Workstation
	Tools that Require Registering ALM Client Components


	Installing HP ALM Add-ins
	Verifying the IIS Configuration
	Configuring IIS 7.0
	Configuring IIS 6.0
	IIS Account Settings
	ALM Virtual Directory Settings


	Customizing ALM
	Customizing the SA Repository and Application
	Customizing the Site Administration Repository
	Customizing the qcbin Application

	Customizing Module Names and Menus

	Changing the JBoss Heap Memory Size and Port
	Changing the JBoss Heap Memory Size
	Changing the JBoss Heap Size on Windows
	Changing the JBoss Heap Size on Unix Systems

	Changing JBoss Port Numbers
	Changing Ports Used by JBoss Internal Processes

	Uninstalling ALM Platform
	Uninstalling ALM Platform from Windows
	Uninstalling ALM Platform from Unix Platforms
	Uninstalling ALM Components from a Workstation

	Troubleshooting ALM Platform Installation
	Disabling Validation Checks for the Configuration Wizard
	Checking the Installation and Configuration Log Files
	ALM Platform Installation Already Exists
	Database Validator Fails
	IIS Site Not Responding
	ALM Service Does Not Start
	JBoss Does Not Start

	LW-SSO Authentication - General Reference
	LW-SSO Authentication Overview
	LW-SSO Token Expiration
	Recommended Configuration of the LW-SSO Token Expiration
	GMT Time
	Multi-domain Functionality
	Get SecurityToken for URL Functionality

	LW-SSO System Requirements
	LW-SSO Security Warnings
	Troubleshooting and Limitations
	Known Issues
	Limitations





<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (Adobe RGB \0501998\051)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize false
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile (None)
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /JPXEncode
  /AutoFilterColorImages false
  /ColorImageAutoFilterStrategy /JPEG2000
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 100
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /JPXEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG2000
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 100
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck true
  /PDFX3Check false
  /PDFXCompliantPDFOnly true
  /PDFXNoTrimBoxError false
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier (CGATS TR 001)
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<
    /CHS <>
    /CHT <>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA (Utilizzare queste impostazioni per creare documenti Adobe PDF che devono essere conformi o verificati in base a PDF/X-1a:2001, uno standard ISO per lo scambio di contenuto grafico. Per ulteriori informazioni sulla creazione di documenti PDF compatibili con PDF/X-1a, consultare la Guida dell'utente di Acrobat. I documenti PDF creati possono essere aperti con Acrobat e Adobe Reader 4.0 e versioni successive.)
    /JPN <>
    /KOR <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die moeten worden gecontroleerd of moeten voldoen aan PDF/X-1a:2001, een ISO-standaard voor het uitwisselen van grafische gegevens. Raadpleeg de gebruikershandleiding van Acrobat voor meer informatie over het maken van PDF-documenten die compatibel zijn met PDF/X-1a. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 4.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings when submitting to HP. These settings require font embedding.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /HighResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice




